Rosemount™ 3410 Series Gas Ultrasonic Flow Meters

Models 3415, 3416 and 3417
Safety and approval information

This Rosemount product complies with all applicable European directives when properly installed in accordance with the instructions in this manual. Refer to the EU declaration of conformity for directives that apply to this product. The EU declaration of conformity, with all applicable European directives, and the complete ATEX Installation Drawings and Instructions are available on the internet at www.emerson.com or through your local Emerson support center.

Information affixed to equipment that complies with the Pressure Equipment Directive, can be found on the internet at www.emerson.com.

For hazardous installations in Europe, refer to standard EN 60079-14 if national standards do not apply.

Other information

Full product specifications can be found in the product data sheet. Troubleshooting information can be found in the user manual. Product data sheets and manuals are available from the Emerson website at www.emerson.com.

Return policy

Follow Emerson procedures when returning equipment. These procedures ensure legal compliance with government transportation agencies and help provide a safe working environment for Emerson employees. Emerson will not accept your returned equipment if you fail to follow Emerson procedures. Return procedures and forms are available on our web support site at www.emerson.com, or by phoning the Emerson Customer Service department.

Emerson Flow customer service

Email:
- Worldwide: flow.support@emerson.com
- Asia-Pacific: APflow.support@emerson.com

Telephone:

<table>
<thead>
<tr>
<th>North and South America</th>
<th>Europe and Middle East</th>
<th>Asia Pacific</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States</td>
<td>800 522 6277</td>
<td>Australia</td>
</tr>
<tr>
<td>Canada</td>
<td>+1 303 527 5200</td>
<td>800 158 727</td>
</tr>
<tr>
<td>Mexico</td>
<td>+41 (0) 41 7686 111</td>
<td>New Zealand</td>
</tr>
<tr>
<td>Argentina</td>
<td>+54 11 4837 7000</td>
<td>800 440 1468</td>
</tr>
<tr>
<td>Brazil</td>
<td>+55 15 3413 8000</td>
<td>Pakistan</td>
</tr>
<tr>
<td>Central &amp; Eastern</td>
<td>+41 (0) 41 7686 111</td>
<td>888 550 2682</td>
</tr>
<tr>
<td>Russia/CIS</td>
<td>+7 495 981 9811</td>
<td></td>
</tr>
<tr>
<td>Egypt</td>
<td>0800 000 0015</td>
<td></td>
</tr>
<tr>
<td>Oman</td>
<td>800 70101</td>
<td></td>
</tr>
<tr>
<td>Qatar</td>
<td>431 0044</td>
<td></td>
</tr>
<tr>
<td>Kuwait</td>
<td>663 299 01</td>
<td></td>
</tr>
<tr>
<td>South Africa</td>
<td>800 991 390</td>
<td></td>
</tr>
<tr>
<td>Saudi Arabia</td>
<td>800 844 9564</td>
<td></td>
</tr>
<tr>
<td>UAE</td>
<td>800 0444 0684</td>
<td></td>
</tr>
</tbody>
</table>
Contents

Chapter 1  Maintenance..............................................................................................................................5
  1.1 Precautions for meter maintenance............................................................................................5
  1.2 Field hydrostatic pressure testing procedures........................................................................6
  1.3 Routine maintenance..................................................................................................................7

Chapter 2  Troubleshooting..................................................................................................................13
  2.1 Meter status alarms..................................................................................................................13
  2.2 Troubleshooting the meter......................................................................................................15
  2.3 Troubleshoot maintenance log files and trend files.............................................................33
  2.4 Meter reset mode....................................................................................................................34

Chapter 3  Meter repairs...........................................................................................................................37
  3.1 Precautions prior to repairs.....................................................................................................37
  3.2 T-Slot transducer removal and installation............................................................................40
  3.3 T-Slot transducer holder removal and installation...............................................................48
  3.4 T-200 transducer assembly removal and installation...........................................................52
  3.5 T-200 transducer capsule assembly removal and installation............................................56
  3.6 T-200 transducer housing removal and installation.............................................................60
  3.7 Transducer cable removal and installation............................................................................62
  3.8 Replace the meter electronics.................................................................................................68
  3.9 Acquisition Module replacement............................................................................................78

Appendix A  Conversion factors...........................................................................................................85
  A.1 Conversion factors per units of measurement.................................................................85
  A.2 K-Factor and inverse K-Factor conversions........................................................................86

Appendix B  Engineering drawings.......................................................................................................87
  B.1 Rosemount™ 3410 Series Ultrasonic Flow Meter Drawings............................................87
1 Maintenance

1.1 Precautions for meter maintenance

This section includes discussion of the maintenance of Rosemount™ 3410 Series Ultrasonic Meters.

For reference, you may download the MeterLink Quick Start Manual from: www.emerson.com/meterlink.

⚠️ CAUTION

SURFACE TEMPERATURE HAZARD
The meter body and piping may be extremely hot or cold.
Wear appropriate personal protective equipment when coming in contact with the meter.
Failure to comply may result in injury.

⚠️ CAUTION

TRANSPORTATION HAZARD
When moving the meter, do not insert the forks of a forklift into the bore.
Inserting the forks may cause the meter to become unstable, resulting in injury or damage to the bore and sealing face.

⚠️ CAUTION

TRIPPING HAZARD
Clear all obstacles or obstructions from the work area when transporting, installing or removing the meter.
Failure to clear the work area may cause injury to personnel.

⚠️ WARNING

CRUSHING HAZARD
Do not remove flange stabilizers.
Attempting to do so could allow the meter to roll, resulting in serious injury or equipment damage.

A. Flange stabilizers
CAUTION

ESCAPING FLUIDS HAZARD
The purchaser of the meter is responsible for the selection of Rosemount components/seals and materials compatible with the chemical properties of the measurement fluid. Failure to select suitable meter components/seals may cause escaping fluids, resulting in injury or equipment damage.

WARNING

HEARING DAMAGE
Wear proper hearing protection before approaching a metering system that is generating a large amount of audible noise. Obey all facility safety rules. Failure to comply could result in temporary or permanent hearing loss.

1.2 Field hydrostatic pressure testing procedures

CAUTION

LEAKAGE OR PRESSURE CONTAINING PARTS FAILURE
Use precautions to eliminate hazards to personnel in the event of leakage or failure of the gas ultrasonic meter pressure containing parts or failure of the test equipment and to prevent over-pressurization during the test procedure. Failure to comply may result in injury to personnel or cause damage to the equipment.

1.2.1 T-Slot transducer assembly and mount

Procedure
1. Slowly vent all line pressure on the 3410 Series Gas Ultrasonic Meter to atmosphere.
2. Disconnect transducer cable from the transducer holder.
3. Loosen the T-Slot transducer assembly with a 1 ¼-in. (32 mm) wrench or socket. Carefully remove the T-Slot transducer assembly.
4. Place a label on the transducer assembly to mark its location. Port locations are marked on the transducer cable as well as on cast meter housings.
5. Apply a small amount of Nickel antiseize compound (P/N 3-9960-134) to the threads of the Hydrotest plug from Hydrotest kit and install it into the mount. Required kit part numbers are listed below.

| Model 3415  | Quantity 1 x 1-360-01-220 |
| Model 3416  | Quantity 1 x 1-360-01-220 |
| Model 3417  | Quantity 2 x 1-360-01-220 |

6. Repeat Step 3 through Step 5 for the other transducer(s) being careful to note the location of each transducer in the meter assembly.
7. Run the field hydrostatic test.
8. Reverse the steps above to reinstall the transducers into their appropriate ports. Before reinstalling the transducer assemblies, ensure the transducer ports, mounts, and transducer holders are clean and free of debris. Apply a small amount of Nickel antiseize compound to the outer threads of the transducer holders before installing them into the mounts.

1.2.2 T-200 transducer assembly
The T-200 transducer assembly has full-metal structure and can remain in place during field hydrostatic pressure test.

Procedure
1. Leave T-200 transducers installed on the 3410 Series Gas Ultrasonic Meter while the line is pressurized.
2. Run the field hydrostatic test.

1.3 Routine maintenance
Routine maintenance operations requires adherence to all applicable regulations and laws and safety training for personnel to perform the maintenance operations. Review your organization’s best practices procedures before performing routine maintenance.

1.3.1 Maintenance logs and reports
To monitor the performance health of the meter, and ensure it is operating within acceptable specifications, routine diagnostics should be performed. Collecting a maintenance log gives you a snapshot of the current health of the meter and you can compare the inspection reports from previously saved logs. Use the Logs/Reports menu and click Maintenance Logs and Reports. MeterLink™ displays the Maintenance Logs and Reports dialog box. Choose the time duration, log format and collection rate for the output file and click the Start button. You can open the file immediately after it is generated or view it at a later time. It is recommended that a Maintenance log be collected after an upset in the system.

In establishing a baseline to be used for the trending of the meter diagnostics, it is very helpful if a set of log files are collected immediately after the meter has been installed in the field. Preferably, collect the log files at several velocities within the operating range of the meter. This helps establish that the flow profile is relatively constant throughout the meters operating range (except velocities below 3 ft/sec where the profile may vary).
Maintenance log collection

Figure 1-1: Maintenance log collection parameters

Trend maintenance log collection

Merging the results of two or more Maintenance logs into a single file, allows you to build a historical database of the meter's performance. Trending the logs indicates changes from the original installation of the meter, or over time. Looking at a single inspection report, that is either collected monthly or quarterly, can give you an indication of the meter's health.
This is important since many diagnostics change slowly over time. Trending the maintenance logs helps identify these changes and makes problems much more obvious than merely viewing a single inspection report. The Trending feature is integral to MeterLink™ which allows all important parameters to be trended. MeterLink supports trending files in a Microsoft® Excel® workbook from multiple 3410 Series meter maintenance logs. Some parameters like gain, signal level, and noise level may show a shift over time which can be useful in detecting changes in the meter and the installation.

Archive log collection

Archive logs may be collected and the options include:
- Daily log - generated every 24 hours on the Contract Hour
- Hourly log - generated every hour at the top of the hour
- Event log - collects the alarm and event log records
1.3.2 Pipe cleaning maintenance

⚠️ WARNING

BURST HAZARD
Before pipeline cleaning and maintenance ("pigging operations"), remove straightening vanes or flow conditioners.
Failure to comply may cause excessive pressure in the meter system, resulting in death, serious injury or equipment damage.

Figure 1-4: 3410 Series Gas Ultrasonic Flow Meter with flow conditioner for unidirectional flow

![Figure 1-4](image)

- Flow Conditioner: Rosemount™ Profiler, CPA 50E or CPA 55E

Figure 1-5: 3410 Series Gas Ultrasonic Flow Meter with flow conditioner for bidirectional flow

![Figure 1-5](image)

1. Flow Conditioner: Rosemount Profiler, CPA 50E or CPA 55E
2. Flow Conditioner: Rosemount Profiler, CPA 50E or CPA 55E

Straightening vanes or flow profilers must be removed during pipeline cleaning maintenance operations ("pigging operation"). If the meter run is pigged with a flow conditioner in line, pressure may build up and cause the pipes and flanges to burst and severely injure personnel. The excessive pressure may damage the meter or the transducer ports may collect debris which may impede data acquisition and flow measurement.

1.3.3 Visual inspection

Periodically inspect the meter and meter run for signs of components loosening or seals leaking. This includes:
Procedure

1. Fluids leaking from seals. This could be visually noticed for liquids leaking. It may be audible for gasses leaking. Ice may also form at a point of a gas leak.
2. Movement of components that should be rigid.
3. Excessive noise due to vibration could be sign of a loose component.
   Inspection should be more frequent in systems with a large amount of vibration.
2 Troubleshooting

2.1 Meter status alarms

Run MeterLink™ and open the Meter Monitor (Summary) view to perform a diagnostics health check.

Figure 2-1: Meter Monitor status alarms

If the meter is measuring flow and operating within the calibration parameters the Meter Status LED is green. If the Meter Status LED is red, an active alarm exists that requires you to take corrective action. Click the **Check Status** button to display the Status Summary screen. The alarms are shown with the primary causes listed first. Click the **question mark**, next to the alarm to display a help topic related to the alarm and recommended actions to resolve the issue.

Figure 2-2: Status summary
2.1.1 Check status

Click the **Check Status** button if any of the LEDs are yellow or red to see more specific information causing the status alarm. Some alarms do not require an acknowledge and will clear automatically when the alarm condition goes away. Alarms that require a user to acknowledge them will have a button to the right titled **ACK**. Clicking the **ACK** button changes the button text to **Wait** and sends a request to the meter to clear the alarm. The alarm will disappear from the Check Status dialog once the alarm actually clears.

Click the **Check Status** button and MeterLink™ opens the Status Summary dialog box that gives a short description of all alarms present.

**Figure 2-3: Status Summary**

A. Active alarm conditions from Meter Monitor page

B. Status summary page with alarm examples

Following is a list and a brief description of the types of alarms:

- System
- Power Loss
- Field I/O
- Validity
- Comms
- Check Status

2.1.2 System alarm

The System alarm indicates a failure in the hardware that should be addressed by a service technician. This includes memory checksum errors and communication errors within the hardware. A Red LED indicates a system alarm condition. Collect a Maintenance log and an audit/alarm log and then, contact your Emerson Flow service representative. This could be an alarm condition that occurred and remains latched until the condition is resolved and the alarm is cleared by clicking the **ACK** button on the **Monitor → Check Status → Status Summary** page.

2.1.3 Chord A, Chord B, Chord C and Chord D alarm

Chord A, Chord B, Chord C and Chord D - These alarms indicate how a chord is functioning.
Table 2-1: LED colors

<table>
<thead>
<tr>
<th>LED Color</th>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>No alarms are present. Chord is operating properly.</td>
</tr>
<tr>
<td>Yellow</td>
<td>The chord has failed or is in acquisition. This chord is not used for this batch. Chord that have failed or are shown to be in acquisition for repeated batches indicates that the meter should be inspected by a service technician. The chord has manually been set to inactive. At least one sample in the batch caused an alarm but it did not cause the chord to fail. The sample will not be used in the batch. Discarding occasional samples can occur during normal operation such as during flow velocity changes.</td>
</tr>
<tr>
<td>Red</td>
<td>The in-use length is not equal to the calculated length for chord. If this is a new meter or an upgraded meter, check that the chord length and correct if needed. If incorrect, check all meter parameters against the meter Zero Flow Calibration report. This report can be requested from your local area Emerson Flow service representative.</td>
</tr>
<tr>
<td>Gray</td>
<td>The chord has manually been set to inactive.</td>
</tr>
</tbody>
</table>

2.1.4 Field I/O alarm

Reports various field I/O devices that are in alarm. Click the **Check Status** button for more details on specific alarms. The field is grayed out if the Rosemount™ 3410 Series Ultrasonic Gas Flow Meter does not support this alarm.

2.1.5 Validity alarm

This alarm indicates that the meter may not be measuring accurately. Click **Check Status** to see a description of which validity alarms are active. The validity alarms **QMeter** and **QFlow** indicate an issue with the meter collecting enough information from the chords to make an accurate measurement. The validity alarms for pressure and temperature indicate that the value is above or below the alarm limits for these values. Red and green are the only colors used for this alarm.

2.1.6 Comms alarm

The Comms alarm indicates that communications between MeterLink™ and the meter failed. This could be due to a poor communication link. MeterLink continues to retry communications. Red and green are the only colors used for this alarm.

2.1.7 Communications

The Communications Analyzer (via MeterLink™ **Tools → Menu → Communications Analyzer** menu path) displays communications between MeterLink and the ultrasonic meter. This utility is useful for troubleshooting communications to the meter. It displays many of the TCP/IP commands between MeterLink and the connected meter.

2.2 Troubleshooting the meter

*Table 2-2* and the following sections show errors that may occur with the meter hardware, firmware or connections and recommend actions to resolve the problem(s).
### Table 2-2: Troubleshooting

<table>
<thead>
<tr>
<th>Error</th>
<th>Recommended action(s)</th>
</tr>
</thead>
</table>
| Acquisition Module Error             | • Check/Replace I.S. Barrier.  
• Check/Replace Acquisition module.  
• Attempt the Program Download procedure to install the firmware.  
  — Cycle power to the meter.  
  — Replace the Acquisition Module.  
  — If the Acquisition Module cannot be reprogrammed, collect a complete Archive log and contact your local area Emerson Flow service representative. |
| Acquisition Module is not compatible with firmware | • Check Acquisition Module is compatible with Model # configured in meter (i.e. 3414 4-path or 3418 8-path).  
• Replace the Acquisition Module. |
### Table 2-2: Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Error</th>
<th>Recommended action(s)</th>
</tr>
</thead>
</table>
| Chord failure       | • Chord is hard failed, and meter is unable to obtain measurement data from a pair of transducers.  
|                     | — If a chord is failed and no other transducers are failed or are reporting status alerts, the issue is most likely isolated to this pair of transducers or its cabling. Check the transducer wiring for this pair of transducers to make sure connections are secure and wired correctly.  
|                     | — Remove the transducer cable from the transducer and measure the resistance with an Ohm meter.  
|                     |  • For T-11 and T-12 transducers, remove the transducer cable from the transducer and measure the resistance with an ohm meter across the two pins on the back of the transducer holder. If the value is over 2 ohms, replace the transducers.  
|                     |  • For T-21, T-22, T-32 and T-41 transducers, remove the transducer cable and transformer assembly and measure the resistance with an ohm meter. If the value is not 1 Mohm +/- 0.2 Mohm, try cleaning the pins with alcohol and a small object like a toothpick to see if that lowers the resistance. If not, replace the transducers. Measure the resistance across the two pins on the transformer module that lead to the electronics. If the value is over 2 ohms, replace the transformer module. Measure the resistance across the two pins on the transformer module that lead to the electronics. If the value is over 2 ohms, replace the transformer module. Measure the resistance across the two pins on the transformer module that lead to the transducer. If the value is not between 30 and 40 ohms for the T-21 and T-41 transformer module, replace the transformer module. If the value is not between 50 and 75 ohms for the T-22 transformer module, replace the transformer module. If the value is not between 7 and 12 ohms for the T-32 transformer module, replace the transformer module. If possible, measure the capacitance of the transducer with an LCR meter. If the value is not between 450 and 600 pf for the T-21 and T41 transducer, replace the transducer. If the value is not between 215 and 350 pf for the T-22 transducer, replace the transducer. If the value is not between 400 and 550 pf for the T-32 transducer, replace the transducer.  
|                     |  • For T-200 transducers, remove the transducer cables from the transducers and measure the resistance with an ohm meter across the two pins on the back of the transducer capsules. If the values are over 2 ohms, replace the transducer capsules. If the values are under 2 ohms, remove the transducer capsules, clean and reapply the coupling fluid to the front face of the transducer capsules, and reinstall the transducer capsules. If this does not correct the issue, replace the transducer capsules.  
|                     | — If transducer cabling allows, swap cabling of failed transducer pair with a pair with equal path lengths. If the alarm remains active for this chord, then the transducers are working properly. If this alarm clears but the chord that was swapped now fails, the issue is with the transducer.  
|                     | — Collect a Maintenance Log, Configuration file and Waveform stream file with MeterLink and contact your Emerson Flow service representative. |
### Table 2-2: Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Error</th>
<th>Recommended action(s)</th>
</tr>
</thead>
</table>
| CPU Module LINK LED | • When connecting directly:  
  — Check the cross-over cable connection (P/N 1-360-01-596)  
  • When using a Hub:  
  — Use straight-through patch cable between the meter and the hub and a straight-through patch cable between the hub and the PC.  
  — Do not connect either the Rosemount 3410 Ultrasonic Flow Meter or PC to the hub UPLINK port.  
  — Check the CPU Module LED 1 is on (either solid red or flashing green). If the LED is not on, check power to the meter.  
  — If the LED is on, check the Ethernet cable connections. |
| CPU Module LINK LED is on but I can't communicate with the meter using Ethernet | • If you are connecting for the first time, refer to the 3410 Series Installation Manual, in "Wiring and inputs/outputs" for instructions on initial communication (via Ethernet) setup.  
  • Enable the DHCP switch on the CPU Module.  
  • Verify that the PC has received an IP address from the meter as follows:  
  — Bring up DOS prompt window (Start → Run → (type)cmd)  
  — In the DOS prompt window, type ipconfig  
  • If you get the following: IP 192.168.135.35 (note: the last .35 can be up to .44) with a Subnet Mask of 255.255.255.0 and Default Gateway you should be able to connect to the meter.  
  • If you get the following:  
  — Ethernet adapter Local Area Connection 1  
  — IP Address: 0.0.0.0 the PC has not yet received an IP address from the DHCP server wait (up to 30 seconds).  
  — If after 30 seconds the PC has not received an IP address from the DHCP server or the IP address shown above (from ipconfig) is different from the range of 192.168.135.35 through 192.168.135.44, verify that the PC is configured to receive its IP address automatically (via DHCP). |
| Communication line connected to the flow computer but no signal is received | • Check for loose connections at the flow meter and the flow computer.  
  • Check the CPU Module settings. |
### Table 2-2: Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Error</th>
<th>Recommended action(s)</th>
</tr>
</thead>
</table>
| Communication issues due to blocked network ports | • Blocked network ports on the computer running MeterLink or on a company LAN can prevent connections to the meter or prevent certain features from working. These issues may occur over Ethernet, Modem and Direct serial connections. Reference the list of network ports used by MeterLink in the Help file and the symptoms of having blocked ports. Contact your IT department for assistance in resolving these issues.  
  • Error condition of a blocked network:  
    — Cannot connect to a meter  
    — Cannot collect Archive log files  
    — Cannot view or stream waveforms in Waveform Viewer or Signal Analyzer  
    — Cannot upgrade firmware  
    — Communications lost over serial or modem connections while MeterLink is idle on a screen.  
  • Symptoms of blocked network:  
    — If a PING is blocked on this network port, serial or modem connections could be lost after approximately 15 seconds of inactivity. This issue can be confirmed by checking the `log_meter_log_file` in the Temp data folder. The path of the Temp data folder is shown in the MeterLink About dialog.  
    — A blocked FTP port will generally not prevent a connection to the meter, but will prevent log collections and program downloads. A blocked FTP port could prevent a connection in the event the meter is running a newer version of firmware for which MeterLink does not currently have a database configuration file. If this is a case, a message stating “Error reading database config file dbconfig<databaseversion>.xml from the meter.” will be displayed.  
    — A blocked DB API port will report “Error 10001 opening database connection to <IP address>“.  
    — A blocked Streaming port will report an error message “Unable to open a control socket”. This will occur when opening the Signal Analyzer window or clicking Read or Stream to File in the Waveform Viewer. |
| Communicating with meter but all chords display failures | • Verify that the resistance of transducers is within Specification (2 Ω).  
  • Check the Acquisition Module.  
  • Check the interconnect cables between the Base assembly and the Transmitter Electronics Enclosure. |
| Cannot communicate with MeterLink program | • Ensure that the meter is properly powered.  
  • Ensure that the computer cable is properly connected and check your interface pins (RS-485 or RS-232).  
  • Verify that the communication parameters of the MeterLink program are correctly set.  
  • Check RS-485 or RS-232 communication LEDs. |
<table>
<thead>
<tr>
<th>Error</th>
<th>Recommended action(s)</th>
</tr>
</thead>
</table>
| Cannot communicate with Field Communicator | • Refer to the Emerson 475 Field Communication User’s Manual, Rev D. This manual may be downloaded from the following location: www.fieldcommunicator.com.  

**Note**  
The 375 Field Communicator is no longer available for purchase since the release of the 475 Field Communicator. Customer supports remains available. |
| Cannot communicate with AMS Device Manager | • Refer to the AMS Books Online help documentation and support at the following web site: www.emerson.com/en-us/automation/asset-management/field-device-management/assetmanagement-software/ams-device-manager. |
| Connect to multiple meters via Ethernet when they are on the same LAN | • Configure each meter with a unique user-specified IP address (following the initial communication quick start instructions the 3415, 3416 and 3417 Installation manual, Serial connections in 00825-0200-3104).  
• Contact your IT department for valid IP addresses for your LAN and Gateway addresses.  
• Disable the DHCP server. |
| Connect to multiple meters via Ethernet when they are on the same hub but not connected to an intranet LAN | • Configure each meter with a unique user-specified IP address following the initial communication quick start instructions (the 3415, 3416 and 3417 Installation manual, Serial connections in 00825-0200-3104).  
• Assign each meter on the hub a unique IP address within the range 192.168.135.150 through 192.168.135.254 (Gateway address for each meter may be left unconfigured as 0.0.0.0).  
• A PC may receive its IP address from an external DHCP server; in this case, one and only one meter must have its DHCP server enabled (the DHCP server will serve up to 10 IP addresses to PCs attempting to talk to all meters on the hub).  
• Once a meter's IP address is configured, the meter may be connected to the hub and accessed using that IP address. |
| Configuration changed | • One or more parameters have been modified in the meter’s configuration,  
  — Collect an Audit log using MeterLink in order to see what configuration parameters changed and when they changed.  
  — Run the Tools → Edit/Compare Configuration utility and select Write All or Write Checked values to write the changes to the meter.  
  — Save the configuration file. |
<table>
<thead>
<tr>
<th>Error</th>
<th>Recommended action(s)</th>
</tr>
</thead>
</table>
| Configuration lost | - The meter configuration has reset to default values and the meter is not configured correctly to measure flow and the meter has performed a Cold Start.  
  - Unless the Cold Start occurred after upgrading firmware, replace the CPU board.  
  - If the cold start occurred after a firmware upgrade, fully reconfigure the meter from a previously saved configuration using the **Tools → Edit/Compare Configuration** in MeterLink. For Rosemount Series 3410 Firmware v1.60 and later, the user database must be either imported from a saved user database using **Meter → Manage Users** dialog box or manually reentered using the same dialog box. |
| Electronics Temperature is Out of Nominal Range | - Temperature of the internal electronics is out of nominal operating range (below -40 °C or above 100 °C) which could lead to a system failure.  
  - Attempt to warm or cool the meter electronics housing.  
  - If the electronics is mounted to the meter and the process fluid in the meter is over 60 °C, you must remote mount the electronics off of the meter body.  
  - Collect a Maintenance log using MeterLink while the meter is experiencing the issue and contact your service representative. |
| Flow pressure is outside the alarm limits | - Startup issues:  
  - Verify that there is voltage to the pressure sensor from either the meter’s power supply board or from an external power supply.  
  - If using an analog pressure device, verify that the pressure sensor is properly wired to the connector.  
  - Verify the input is properly configured for your pressure input.  
  - If using a flow computer to write pressure to the meter, verify that it is properly writing to fixed flow pressure in the proper units.  
  - Run time issues:  
  - Adjust pressure of process fluid to within alarm limits.  
  - If using an analog pressure device and input reading is 0, check if **IsAI1Avail** is equal to 1 in the Meter Information dialog in MeterLink. If it is not 1, either the I/O Board has been removed or is damaged. Reinstall or replace the board if this value is 0.  
  - If using an analog pressure device, verify that the pressure sensor is working properly.  
  - If using an analog pressure device, recheck wiring and switch settings.  
  - If a flow computer is writing values to the fixed flow pressure, verify that the flow computer is still writing valid values without Modbus write errors.  
  - Reverify the pressure input settings are correct. |
| Program download failed during firmware upgrade | - If meter experiences a power loss in the middle of a firmware upgrade, the meter may become unresponsive and communications to the meter may not be possible. If this occurs, contact Emerson Flow Support for assistance. |
Table 2-2: Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Error</th>
<th>Recommended action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>No power to the unit</td>
<td>• Check for correct voltage (10.4 - 36 VDC) (refer to the System Wiring Diagram (DMC-005324) in Rosemount™ 3410 Series Ultrasonic Flow Meter Drawings).</td>
</tr>
<tr>
<td></td>
<td>• Check the main power source for blown fuse or tripped circuit breaker. Reference your “as built” installation drawings for your location.</td>
</tr>
<tr>
<td>One or more of the chords is not indicating a reading (reporting zeros)</td>
<td>• Check for loose connections at the cable connectors.</td>
</tr>
<tr>
<td></td>
<td>• Check the resistance of the transducers (should be approximately 2 Ω).</td>
</tr>
<tr>
<td></td>
<td>• Problem also may be caused by a bad Acquisition Module or interconnect cable.</td>
</tr>
<tr>
<td></td>
<td>• Check system status in the MeterLink program for any flagged errors.</td>
</tr>
<tr>
<td></td>
<td>• Check the CPU Module.</td>
</tr>
<tr>
<td></td>
<td>• If Chord A is not indicating, Change the transducer cables from Chord B to chord A. If Chord B then fails, the transducers are bad on Chord A.</td>
</tr>
<tr>
<td>Power Failure</td>
<td>• Meter has had power removed for a period of time or the meter restarted itself such as after a firmware upgrade. The Audit log in the meter indicates the power fail time.</td>
</tr>
<tr>
<td></td>
<td>— If this was an unexpected restart of the meter, verify the integrity of the power to the meter and make sure that the voltage level is in the range of 11-36 VDC at the meter.</td>
</tr>
<tr>
<td></td>
<td>— If this was a known power fail or restart of the meter, just acknowledge this alarm.</td>
</tr>
<tr>
<td>Sound velocity is outside defined limits</td>
<td>• The meter's measured average sound velocity is outside the defined limits.</td>
</tr>
<tr>
<td></td>
<td>— Verify that all chords are measuring the same Speed of Sound within about 0.15%. Look for alarms that indicate transducer problems and resolve any of these issues. This could include failing transducers, debris buildup on transducers, or incorrectly entered path lengths in the configuration.</td>
</tr>
<tr>
<td></td>
<td>— If the chords agree, adjust the SSMin or SSMax using the Edit/Compare Config utility in MeterLink™ so the meter’s average speed of sound falls within these limits.</td>
</tr>
<tr>
<td></td>
<td>— Collect a Maintenance log using MeterLink and contact your Emerson Flow service representative.</td>
</tr>
<tr>
<td>Waveform contains an excessive amount of noise</td>
<td>• Use the MeterLink Meter → Signal Analyzer to increase the StackSize until noise level decreases (settings can be 1 (none) 2, 4, 8, or 16).</td>
</tr>
<tr>
<td>(Only for dual-config) Transducer Firing</td>
<td>• The acquisition Modules of the dual configuration meters are not synchronizing transducers firings.</td>
</tr>
<tr>
<td>Synchronization Error</td>
<td>The acquisition Modules of the dual configuration meters are not synchronizing transducers firings.</td>
</tr>
<tr>
<td></td>
<td>Check physical cable attached between the two Acquisition Modules of dual-configuration meter. (4 Pin connector J6)</td>
</tr>
</tbody>
</table>
Table 2-2: Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Error</th>
<th>Recommended action(s)</th>
</tr>
</thead>
</table>
| **(Only for dual-config)** Dual-Configuration meter communication error | Transmitter Head 1 and Head 2 are not communicating to each other, and are not sharing data.  
Check operation of adjacent Transmitter Head for power fail or other alarm condition.  
Check Ethernet settings for Head 1 and Head 2.  
Check physical connections for Ethernet between Head 1 and Head 2. |

2.2.1 Meter monitoring maintenance

The Monitor (Summary) includes the direction of flow measurement, velocity rate, units of measurement, uncorrected or corrected flow (if applicable for your meter) and a bar graph for a visual comparison between the velocities for each chord. This is the default view displayed when you select **Meter → Monitor** from the toolbar.

Figure 2-4: Meter Monitor (Summary) view

Run MeterLink and open the Meter Monitor (Detailed) view to perform a diagnostics health check and or adjust parameters for your site requirements. If you wish to use the Monitor (Detailed) dialog as the default view, click the checkbox in the lower portion of the dialog box.
The following details the information displayed in this dialog box.

- **Flow Properties Table** - the table at the top of the Meter Monitor dialog box shows basic information about the condition of the flow in the meter.
- **Flow Velocity/Flow Ratios Bar Graph** - provides a visual comparison between the velocities for each chord.
- **Chord Speeds of Sound Bar Graph** - a visual comparison between the calculated speeds of sound for each chord.
- **Gain/Performance Bar Graph** - provides either a visual comparison of the average of the upstream and downstream gains for each chord or a visual comparison of the average of the upstream and downstream performance for each chord.
- **Signal to Noise Bar Graph** - provides a visual comparison between the signal to noise ratio for each chord direction.
- **Meter Status Alarms** - provides a visual indication of the meter’s status.
- **Gas Comp** - this dialog shows the gas composition that can be used by the AGA8 or AGA10 gas calculations.
- **Baseline** - this dialog shows the meter’s flow characteristics in comparison to limits defined for the Continuous Flow Analysis features. This dialog is only available for four path meters that support a baseline and a valid Continuous Flow Analysis key.
- **Run time** - displays how long the monitor screen has been collecting data.
- **Meter Time** - the time displayed is the time from the Ultrasonic meter.

**Note**
If the time displayed has a yellow background, that is an indication that the meter’s time is more than 10 minutes apart from the PC’s time.

- **Meter Data List** - displays read-only data selected from the drop-down list.
- **Chart** - the chart utility displays the data collected for the value selected from the Chart drop-down list.
Refer to Table 2-1 for error resolutions and Table 2-2 for meter maintenance hardware diagnostics.

Table 2-3: Meter Monitor maintenance

<table>
<thead>
<tr>
<th>MeterLink utility</th>
<th>Diagnostics</th>
<th>Action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meter Monitor (Summary) view</td>
<td>Check Status for active alarms</td>
<td>• Meter Status LED is green if there are no active alarms. This indicates</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the meter is measuring flow and operating within the calibrated</td>
</tr>
<tr>
<td></td>
<td></td>
<td>parameters.</td>
</tr>
<tr>
<td></td>
<td>![Meter Status] ![Check Status]</td>
<td>• Meter Status LED is red. This indicates an active alarm. Resolve</td>
</tr>
<tr>
<td></td>
<td>![Meter Status] ![Check Status]</td>
<td>and acknowledge active alarms as displayed on the Status Summary page.</td>
</tr>
<tr>
<td></td>
<td>![Meter Status] ![Check Status]</td>
<td>Click the Help button, ![Help] beside the alarm description to display</td>
</tr>
<tr>
<td></td>
<td>![Meter Status] ![Check Status]</td>
<td>information about the alarm and recommended actions to resolve the</td>
</tr>
<tr>
<td></td>
<td>![Meter Status] ![Check Status]</td>
<td>issue.</td>
</tr>
</tbody>
</table>
Table 2-3: Meter Monitor maintenance (continued)

<table>
<thead>
<tr>
<th>MeterLink utility</th>
<th>Diagnostics</th>
<th>Action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meter Monitor (Detailed) view</td>
<td>Flow Profile</td>
<td>• A chord that causes the spread for the Speed of Sound to vary more than 0.35 % of the Average Speed of Sound, the bar for that chord turns yellow.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Clicking one of the arrows at the top left of the graph will change the chart to SOS Differences from the average meter speed of sound. This provides a quick indication on how much spread in speed of sound is between the chords. Negative values are shown in blue.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* Compare Gains and Signal to Noise (SNR) ratios decibel values with the values in the Maintenance log Inspection report from the meter flow calibration.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* Check chord average signal amplitudes with the meter base line values in the Maintenance log Inspection report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* The meter may not be in measurement mode or there are too few operating chords.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* If a chord is hard failed, the Check Status LED will change from green to red. The issue may be the transducer pair for the failed chord or the transducer cabling. Resolve the issue and clear the alarm.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* If installed, check the flow conditioner for blockage.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* If you have enabled the Continuous Flow Analysis feature, from the Meter Monitor (Detailed) view, click the Baseline button. The Baseline Viewer displays the meter’s flow characteristics including: Flow Velocity, Profile Factor, Swirl Angle, Symmetry, Cross-flow, and Path Turbulences.</td>
</tr>
</tbody>
</table>
### Table 2-3: Meter Monitor maintenance (continued)

<table>
<thead>
<tr>
<th>MeterLink utility</th>
<th>Diagnostics</th>
<th>Action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meter Monitor (Summary) view Meter Flow Properties Table</td>
<td>Flow velocity</td>
<td>• Check the flow direction. If reverse flow is detected, check for valve leaks.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the meter run typically has reverse flow when flow is stopped, reconfigure the <strong>ReverseFlowVolLmt</strong> to allow a higher volume from the <strong>Field Setup Wizard → General Page</strong>.</td>
</tr>
<tr>
<td>Meter Monitor (Detailed) view Monitor Chart Selection list</td>
<td>Speed of Sound</td>
<td>• Compare Speed of Sound deviation from measured SOS relative to the average SOS.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Check the chord's SOS.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Check and correct geometry configuration (pipe diameter, distance between the transducers (LA), and delay time).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If present, resolve transducer issues (failed transducer, cabling or debris buildup on the transducer face, or path length configured incorrectly).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Adjust <strong>SSMin</strong> or <strong>SSMax</strong> only if other checks pass (consult a Emerson Flow Service representative before making these adjustments).</td>
</tr>
<tr>
<td>Meter Monitor (Detailed) view Meter Data List</td>
<td>Electronics Temperature of out range</td>
<td>• Temperature of the electronics is out of nominal operating range below -40 °C or above 100 °C (-40 °F or above 212 °F).</td>
</tr>
</tbody>
</table>
### Table 2-3: Meter Monitor maintenance (continued)

<table>
<thead>
<tr>
<th>MeterLink utility</th>
<th>Diagnostics</th>
<th>Action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Electronics temperatures</strong></td>
<td><strong>Description</strong></td>
<td><strong>Value</strong></td>
</tr>
<tr>
<td>Meter Monitor (Detailed) view</td>
<td><strong>System temperature</strong></td>
<td>101</td>
</tr>
<tr>
<td></td>
<td><strong>System temperature - Acquisition Module</strong></td>
<td>74</td>
</tr>
<tr>
<td></td>
<td><strong>Frequency output</strong></td>
<td></td>
</tr>
<tr>
<td>Meter Data List</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Electronics voltages</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>System voltages are valid if 1.0 V, 1.2 V, 2.5 V, 3.3 V or the Acquisition Module valid voltages are 1.2 V, 2.5 V or 3.3 V.</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Replace the CPU Module if one or more of the System Voltages is out of range.</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Replace the Acquisition Module if one or more of the voltages is out of range.</strong></td>
<td></td>
</tr>
<tr>
<td>MeterLink Tools Menu</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Tools</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Loops/Reports</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Calibration</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Edit/Compare Configuration...</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Waveform Viewer...</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Gas SIS Calculator...</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Outputs Test...</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Transducer Swap-Out...</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Set Deadtime Wizard...</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Program Download...</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Communications Analyzer...</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Systems voltages are valid if 1.0 V, 1.2 V, 2.5 V, 3.3 V or the Acquisition Module valid voltages are 1.2 V, 2.5 V or 3.3 V.
- Replace the CPU Module if one or more of the System Voltages is out of range.
- Replace the Acquisition Module if one or more of the voltages is out of range.

- Frequency output
  - Run the Frequency Outputs test
  - If the output reads zero, you may require a pull up resistor 1.2k OHM, 0.5 W.
Table 2-3: Meter Monitor maintenance (continued)

<table>
<thead>
<tr>
<th>MeterLink utility</th>
<th>Diagnostics</th>
<th>Action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Analog outputs</td>
<td>• Run Analog Outputs test</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Verify outputs are within 4 mA - 20 mA range</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0% = 4 mA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 25% = 8 mA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 50% = 12 mA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 75% = 16 mA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 100% = 20 mA</td>
</tr>
<tr>
<td></td>
<td>• Digital outputs</td>
<td>• Run the Digital Outputs test</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Digital Output Content is in relation to frequency validity and flow direction configuration and polarity.</td>
</tr>
</tbody>
</table>

---

**Meter Electronics**

- **Acquisition Module communications error**
  - Check firmware revision and upgrade if necessary using MeterLink **Tools → Program Download**.
  - Check for 5V between pins 1 and 2 on I.S. Barrier cable.
### Table 2-3: Meter Monitor maintenance (continued)

<table>
<thead>
<tr>
<th>MeterLink utility</th>
<th>Diagnostics</th>
<th>Action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MeterLink Logs/ Reports Menu</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>□ Collect event log: alarms/audit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Event log options</td>
<td>Which type/Newest Record</td>
<td></td>
</tr>
<tr>
<td>□ Collect all</td>
<td>✔ Audit 6/27/2011 2:19:43 PM</td>
<td></td>
</tr>
<tr>
<td>□ Collect 1 day(s)</td>
<td>□ Alarm 6/27/2011 2:19:57 PM</td>
<td></td>
</tr>
<tr>
<td>□ Since last collection</td>
<td>□ System 6/27/2011 2:19:56 PM</td>
<td></td>
</tr>
<tr>
<td>Audits: 794</td>
<td>Alarms: 3000</td>
<td>System messages: 3000</td>
</tr>
</tbody>
</table>

**MeterLink Tools → Edit/ Compare Configuration menu**

- Meter performed a Cold start

**MeterLink Logs/Reports Menu**

- Power failure

- Meter performed a Warm start or a Warm start required

- Meter performed a Warm start:
  - Collect an Archive event log (Audit log) using MeterLink to view configuration parameter changes and when they changed.

- Warm start is required:
  - When you make changes to the transducer characteristics, sample rates, the device number, or a Modbus map file.

- The meter configuration has reset to default values and the meter is not configured correctly to measure flow.

- Unless the cold start occurred after upgrading firmware, you may need to replace the CPU Module.

- If the Cold Start occurred after a firmware upgrade, you must reconfigure the meter from a previously saved configuration file using the **Edit → Compare Configuration** screen. For Rosemount Series 3410 Firmware v1.60 and later, the user database must be either imported from a saved user database using **Meter → Manage Users** dialog box or manually reentered using the same dialog box. Then clear the latched alarm on the Status Summary page.

- If this was a known power fail or restart of the meter just acknowledge this alarm on the Status Summary page.

- If this was an unexpected restart of the meter, verify the integrity of the power to the meter and make sure that the voltage level is in...
Table 2-3: Meter Monitor maintenance (continued)

<table>
<thead>
<tr>
<th>MeterLink utility</th>
<th>Diagnostics</th>
<th>Action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MeterLink utility</strong></td>
<td><strong>Diagnostics</strong></td>
<td><strong>Action(s)</strong></td>
</tr>
<tr>
<td>✔ Collect event log; alarm/audit</td>
<td>Event log options:</td>
<td>the range of 11-36 VDC at the meter.</td>
</tr>
<tr>
<td></td>
<td>Collect all</td>
<td>• Collect a complete Archive log and contact your local area Emerson Flow service representative.</td>
</tr>
<tr>
<td></td>
<td>Collect 1 day</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Since last collection</td>
<td></td>
</tr>
<tr>
<td>Audits: 794</td>
<td>Alarms: 3000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>System messages: 3000</td>
<td></td>
</tr>
<tr>
<td>MeterLink Meter Monitor (Summary) view</td>
<td>Chord failure MeterLink</td>
<td>The meter is unable to obtain measurement data from a pair of transducers.</td>
</tr>
<tr>
<td></td>
<td>System</td>
<td>• The cause may be isolated to one pair of transducers or its cabling. Check the transducer wiring for this pair of transducers to make sure connections are secure and wired correctly.</td>
</tr>
<tr>
<td></td>
<td>Chord A</td>
<td>• Verify the average gain of this transducer pair is not above 90dB. Read the value from the MeterLink Monitor Page or using AMS under Service Tools → Path performance.</td>
</tr>
<tr>
<td></td>
<td>Chord B</td>
<td>• Remove the transducer and clean the transducer face (Transducer removal procedure).</td>
</tr>
<tr>
<td></td>
<td>Chord C</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Chord D</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Field I/O</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Profile</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SOC</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Liquid</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Validity</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Comma</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Check Status</td>
<td></td>
</tr>
<tr>
<td>Security seals</td>
<td>Endcap seals</td>
<td>Only authorized personnel may remove security seals. Follow your standard operating procedure to report seals that have been tampered with or removed and replace the seals per instructions in &quot;Security seal installation&quot; in the Installation manual (00825-0200-3104).</td>
</tr>
<tr>
<td></td>
<td>Endcaps latches</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Transmitter Electronics Enclosure</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Base Enclosure</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shroud seals</td>
<td></td>
</tr>
<tr>
<td>External ground wiring</td>
<td>Transmitter Electronics Enclosure ground lug</td>
<td>Inspect ground lug wiring and make sure the wiring is tightly secured.</td>
</tr>
</tbody>
</table>
### Table 2-3: Meter Monitor maintenance (continued)

<table>
<thead>
<tr>
<th>MeterLink utility</th>
<th>Diagnostics</th>
<th>Action(s)</th>
</tr>
</thead>
</table>
| Conduit seals     | • Transmitter Electronics Enclosure | • Inspect the conduit sealant and follow your standard operating procedure to report tampering with the conduit sealant.  
• Your operating procedures may require a certified electrician and company witness to reseal the conduit. |
|                   |             |           |
|                   | • Inspect for leaks  
• Inspect flange stabilizers | • Perform leak tests on flanges.  
• Ensure flange stabilizers are installed. |
| Flanges           |             |           |

⚠️ **WARNING**

CRUSHING HAZARD  
Do not remove flange stabilizers.  
Attempting to do so could allow the meter to roll, resulting in serious injury or equipment damage.

---

### 2.2.2 Unable to connect direct serial or external serial modem

Ensure that you do not have more than one modem driver installed to the same COM port. Typically this will only be necessary if you use one COM port to talk direct (serial communications) and use the same COM port to connect to an external modem. This is an apparent limitation in Microsoft®’s Dial-up Networking. If more than one modem driver is installed for a particular COM port, Dialup Networking will always use the last driver installed regardless of what is selected. The only work around is to only install one modem driver per COM port on the PC at a time. Refer to the MeterLink Quick Start Manual (00809-0100-7630) for phone and modem details. The manual may also be downloaded from the Emerson website.

www.emerson.com/meterlink
2.2.3 Unable to connect to meter

If you receive the error message “Unable to connect to meter” when trying to connect to a Rosemount 3410 Series Gas Ultrasonic Flow Meter, refer to the following:

- Ethernet connections
- Direct serial connections

2.2.4 Ethernet connections

If you received this message while trying to connect over Ethernet, verify you have the correct IP address in the Meter Directory record. If the meter is to assign the IP address, make sure the IP address is set to 192.168.135.100 and that the DHCP switch is in the ON position on the CPU Module. If the meter has a fixed IP address, verify the IP address, Subnet, and Gateway are correct in the meter. If going through a hub, verify that the computer and meter are connected to the hub with straight-through patch cables.

2.2.5 Direct serial connections

Verify the switch settings on the CPU Module. Also verify your wiring between the meter and the computer running MeterLink™ using the Field Wiring drawing DMC-005324, Engineering drawings. Verify the Comms Address and Baud rate are correct in the Meter Directory record.

For additional information on wiring and configuring the meter for the various communication options, refer to the Rosemount 3410 Series Gas Ultrasonic Flow Meters Installation manual (00825-0200-3104).

2.3 Troubleshoot maintenance log files and trend files

2.3.1 Files do not appear in workbook

Maintenance Log files and Trend files that exist on the PC do not appear in the Microsoft® Excel® workbooks tree under Trend Maintenance Logs.

This is most likely caused by the fact that the desired file or files are already open in Microsoft® Excel®. Open files can not be verified as Maintenance Log files or Trend Files by MeterLink and are left out of the list. Simply close the files in Microsoft® Excel® and then close and reopen the Trend Maintenance Logs dialog box to include them in the list.

2.3.2 Microsoft® Excel® Log/Export options are not available

In order for the Excel® log/export options to be available, Excel® must be installed on the machine and at least one printer must be installed under Windows®.

If Excel® is installed and you have printers installed but the Excel® option is still unavailable, it may be because Excel® cannot access the printer driver information of the Windows® default printer. If the Windows® default printer is a network printer and you are not currently connected to the network, then Excel® will most likely not be able to access the printer driver information and MeterLink™ cannot use Excel® to generate reports or logs.

One solution is to install a local printer on your machine tied to LPT1. The local printer driver you installed can be for any printer and the printer does not actually have to exist or be connected to the PC. If you install a local printer, you can configure MeterLink®...
to temporarily change your Windows® default printer over to this local printer while running MeterLink. Do this by selecting this local printer for the Override system default printer selection in the Program Settings dialog. MeterLink will automatically change the Windows® default printer to the selected override printer when it starts and will set the Windows® default printer back to its original printer when it closes.

2.3.3 Maintenance logs or trend files are not created

When using Excel®, some of the worksheets in the Maintenance Logs or Trend files are not created.

If the Inspection sheet of the Maintenance Log file or the Charts sheet of a Trend files are not generated, it is probably because Excel® is not configured to allow MeterLink to run the Visual Basic® script that generates the page. Excel® can be configured to allow MeterLink to run the Visual Basic® script by following the instructions below.

To enable Excel® to work with MeterLink, select Options under the File menu. Under the Trust Center tab, click Trust Center Settings. Under the Macro Settings tab, select Trust access to the VBA project object model.

2.4 Meter reset mode

For Rosemount Series Firmware v1.60 and later, the meter supports a reset mode to configure the meter back to default conditions.

There are two supported modes: Reset users and Cold start meter. Reset users will delete all users in the user database and restore the factory default administrator username and password. Cold start meter will return the entire meter configuration back to default settings, clear all logs, and delete all users in the user database and restore the factory default administrator username and password.

Prerequisites

- The default password is Administrator-XXXX where XXXX is the non-zero padded CPU serial number which can be found on a label on the CPU Module.
- Before proceeding, if you can still connect to the meter, it is recommended that you collect the meter configuration using the Edit → Compare Configuration screen and export the user database using the Meter → Manage Users dialog box.
- The WRITE PROT switch must be off in order to cold start the meter. The users can be reset with the switch on or off.

Procedure

1. Attach your computer with MeterLink™ to the meter that requires a reset using the appropriate cable.

2. To put the meter in reset mode, transition the Port A Override switch on the CPU module from the Off position to the On position three times within five seconds and leave the switch in the On position after the third transition.

   Tip
   Use a retractable ball point pen with the ball point retracted as a tool to transition the switch.

   The meter will stay in this reset mode for two minutes or until the Port A Override switch is turned off.

3. Within the two minutes, connect to the meter with MeterLink. A Meter Reset Mode is enabled dialog box will appear.
4. Click the desired option to either **Reset users** or **Cold start meter**. MeterLink will prompt you to confirm the operation. Once the operation is confirmed, the meter will begin the selected reset operation. MeterLink will disconnect from the meter once the operation has completed.

5. Connect to the meter again using the default administrator username and go to **Meter → Manage Users** to setup new users and change the default password for the administrator user.
   - For added security, the default username for the administrator user can be changed as well.
   - If a **Cold start meter** operation was performed, you must reconfigure the meter from a previously saved configuration file using the **Edit → Compare Configuration** screen.
3 Meter repairs

3.1 Precautions prior to repairs

This section includes discussion of the maintenance of Rosemount 3410 Series Ultrasonic Meters.

For reference, you may download the MeterLink Quick Start Manual from: www.emerson.com/meterlink.

⚠️ CAUTION

SURFACE TEMPERATURE HAZARD
The meter body and piping may be extremely hot or cold.
Wear appropriate personal protective equipment when coming in contact with the meter.
Failure to comply may result in injury.

⚠️ CAUTION

TRANSPORTATION HAZARD
When moving the meter, do not insert the forks of a forklift into the bore.
Inserting the forks may cause the meter to become unstable, resulting in injury or damage to the bore and sealing face.

⚠️ CAUTION

TRIPPING HAZARD
Clear all obstacles or obstructions from the work area when transporting, installing or removing the meter.
Failure to clear the work area may cause injury to personnel.

NOTICE

Prior to lifting the unit, refer to the Rosemount Gas Ultrasonic Flow Meter nameplate or outline dimensional (general arrangement) drawing for the assembled weight.
**WARNING**

CRUSHING HAZARD
Do not remove flange stabilizers.
Attempting to do so could allow the meter to roll, resulting in serious injury or equipment damage.

A. Flange stabilizers

**WARNING**

FLUID CONTENTS MAY BE UNDER PRESSURE
When the meter is under pressure, DO NOT attempt to remove or adjust the transducer holder of the T-Slot transducer assembly, or loosen the screws holding the T-200 transducer assembly.
Attempting to do so could release pressurized gas or fluid, resulting in serious injury or equipment damage.
**WARNING**

CONTENTS MAY BE HAZARDOUS
The meter must be fully depressurized and drained before attempting to remove the transducer holder of T-Slot transducer assembly, or the T-200 transducer assembly. If gas or fluid begins to leak from the transducer holder of T-Slot transducer assembly, or T-200 transducer stalk assembly, stop immediately and reinstall the transducer holder or T-200 stalk assembly.
Failure to comply could cause serious injury or equipment damage.

![A. Transducer holder](image)

**CAUTION**

ESCAPING GASES OR FLUIDS HAZARD
The purchaser of the meter is responsible for the selection of Rosemount™ components/seals and materials compatible with the chemical properties of gas flow measurement.
Failure to select the suitable meter component/seals may cause escaping gases or liquids, resulting in injury or equipment damage.
**CAUTION**

ESCAPING GASES OR FLUIDS HAZARD

**Process Seal Materials Single Seal Certification (T-XX and T-200 Transducers)**

- Wetted material for T-XX style transducers are 316SS or Inconel holders with Hastelloy-C pins, Stycast 2850 Epoxy, and glass.
- Wetted materials for T-200 Style transducers are Titanium housing and NBR (Nitrile) or FKM (Viton) O-ring material.

Only Rosemount™ specified o-ring replacements shall be used for process seal o-ring materials for T-200 transducers. No substitutions are allowed to maintain process seal integrity.

Verify chemical compatibility of material with components of process fluid.

Reference Parker Seals – Chemical Compatibility Catalog EPS 5350


Failure to select the suitable meter seals may cause escaping gases or liquids, resulting in injury or equipment damage.

**WARNING**

CRUSHING HAZARD

During meter installation or removal, always place the unit on a stable platform or surface that supports its assembled weight.

Failure to comply could allow the meter to roll, resulting in serious injury or equipment damage.

For basic maintenance, refer to Field hydrostatic pressure testing procedures.

### 3.2 T-Slot transducer removal and installation

The T-Slot transducer assembly offers improved transducer alignment and superior acoustic isolation between the transducer and the meter housing. The net result is improved performance and stability. The assembly is used on Rosemount™ 3417, 3416 and 3415 meters and is line pressure vented. The gas temperature ranges are as shown in Table 3-1.

**Table 3-1: Temperature ranges for transducers, mounts and holders**

<table>
<thead>
<tr>
<th>Transducer type</th>
<th>Temperature range</th>
<th>Mount and holder type</th>
</tr>
</thead>
<tbody>
<tr>
<td>T-21&lt;sup&gt;1&lt;/sup&gt;</td>
<td>-20 to +100 °C (-4 to 212 °F)</td>
<td>Standard mounts/holders/NBR O-ring&lt;br&gt;Inconel Mounts/316L Holders, NBR O-ring&lt;br&gt;Inconel Mounts/Inconel Holders/FKM O-ring&lt;br&gt;Inconel Mounts/316L Holders/FKM O-rings</td>
</tr>
</tbody>
</table>
### Table 3-1: Temperature ranges for transducers, mounts and holders (continued)

<table>
<thead>
<tr>
<th>Transducer type</th>
<th>Temperature range</th>
<th>Mount and holder type</th>
</tr>
</thead>
</table>
| T-22²           | -50 to +100 °C (-58 to 212 °F) | Standard mounts/Holders/NBR O-ring  
|                 |                   | Inconel mounts/316L Holders, NBR O-ring  
|                 |                   | Inconel Mounts/Inconel Holders/FKM O-ring  
|                 |                   | Inconel Mounts/316L Holders/FKM O-rings |
| T-41¹           | -50 to +100 °C (-58 to 212 °F) | Standard mounts/Holders/NBR O-ring  
|                 |                   | Inconel Mounts/316L Holders/NBR O-ring  
|                 |                   | Inconel Mounts/Inconel Holders/FKM O-ring  
|                 |                   | Inconel Mounts/316L Holders/FKM O-rings |
| T-200           | -50 to +125 °C (-58 to 257 °F) | Standard Stalk Assemblies  
|                 |                   | Inconel Stalk Assemblies |

¹T-21 and T-41 transducers use W-01 transformers.  
²T-22 transducers use W-02 transformers.

### 3.2.1 T-slot transducer removal

#### Procedure

1. Blow the line down according to the site standard operating procedures.
2. Ensure that the line pressure is down to atmospheric pressure prior to disassembly.
3. Disconnect transducer cabling from the transducer assembly by removing the retaining clips and pulling the cable plug straight out. Do not twist or rotate the plug.
4. Remove the transformer retainer using a 1 ¼-in. wrench and then disconnect and remove the transformer module (**T-Slot transducer assembly and mount**).

**Note**

T-21 and T-41 transducers use W-01 transformers and T-22 transducers use W-02 transformers.
A. Transducer cable (max. length 15 ft.)
B. Retainer clips
C. Transformer retainer (Standard P/N 1-360-01-958 or High Temperature P/N 1-360-01-978)
D. Transformer module T-21/T-41 (W-01 P/N 1-360-03-090) or T-22 (W-02 P/N 1-360-03-110)
E. Transducer holder
F. Transducer holder O-rings and backer rings
G. Transducer holder set screws
H. Transducer assembly
I. Mount comes with O-ring and backer ring

5. Loosen the T-Slot transducer holder assembly with a 1 ¼-in. socket. Carefully remove the T-Slot transducer assembly.
6. Loosen the three Allen setscrews with a 1/16-in. hex driver securing the transducer assembly and stalk, if installed. Carefully remove the old transducer by pulling it from the T-Slot transducer holder assembly without rotating.

**Important**
Record the “L” dimension of the removed transducers which is used to update the meter configuration after all of the transducers are replaced. Make sure you have the report sheet containing the “L” dimension, Delay Time, and Delta Delay Time for the replacement pair of transducers to use during the Transducer Swap-out procedure in MeterLink.

7. Clean the transducer holder with a dry cloth.
3.2.2 T-Slot transducer installation

Procedure

1. Ensure that the Rosemount™ 3410 Series Ultrasonic Gas Flow Meter transducer port, mount, and T-Slot transducer holder assembly are clean and free of debris.
2. Apply a small amount of Molykote 111 to the female contacts on the transducer.
3. Install the transducer assembly into the transducer holder or into the stalk (if required). The parts are keyed and can only be assembled one way. As the transducers are installed into the holder or stalk assembly, they must be labeled with a marker for future reference (i.e., transducer #1 would be A-1 and transducer #2 would be A-2).
4. Use a 1/16-in. hex driver to equally tighten the three Allen set screws on the transducer holder to secure the transducer assembly and the stalks (if installed).

Figure 3-2: Transducer holder, stalk and transducer assembly

A. Transducer holder
B. Stalk
C. Transducer assembly

Note
Do not apply lubricant to the transducer or stalk O-rings.

NOTICE

Ensure that the transducers identified as belonging to end 1 are installed on end 1 of the meter housing and those identified as belonging to end 2 are installed on end 2 of the meter housing.

5. Replace the O-ring and Backup O-ring on the transducer holder. It is highly recommended that the O-rings be replaced when the transducer is removed from the holder or stalk. Ensure that the contoured side of the backer ring is facing toward the transducer capsule attached to the end of the transducer holder. Lubricate with Molykote 111 Silicone Grease or equivalent.

Note
Replacing the O-rings at this point minimizes the chances of damaging the transducer by dropping it.

6. Apply a small amount of nickel anti-seize (N.A.S.) compound (P/N 2-9-9960-134) to the outer threads of the transducer holder (see Figure 3-2).
7. Carefully install the transducer holder assembly into the transducer mount. Make sure the threads of the holder and mount are correctly aligned. Use a 1 ¼-in. socket and screw the transducer assembly into the mount. Tighten to securely seat the assembly in the mount. Do not over tighten (see Figure 3-3).

8. Install the keyed transformer module into the transducer holder (see Figure 3-3).
   a) Apply a small amount of Molykote 111 to the transformer module O-ring.
   b) Insert the keyed transformer module into the back end of the transducer holder.

---

Figure 3-3: T-22 transducer assembly, holder, transformer assembly, retainer, cable nut and chordset

---

A. T-21 transformer assy. (W-01 P/N 1-360-03-090) or T-22 transformer assy. (W-02 P/N 1-360-03-110)

B. Transducer holder (Type - H1 P/N 1-360-01-128, H2 P/N 1-360-01-228)

C. Mount (Inconel mount and holder)

D. Transducer port (meter body)

E. Transducer retainer (Standard P/N 1-360-01-958) (High temperature P/N 1-360-01-978)

F. Cable nut and chordset:
   - 100° C -5’ length (P/N 3-3400-190)
   - 100° C -15’ length (P/N 3-3400-194)
Figure 3-4: T-21 and T-22 transducer assembly, holder, transformer assembly, retainer, retaining clip and transducer cable

A. Mount (Inconel mount and holder)
B. Transducer holder (Type - H1 P/N 1-360-01-128, H2 P/N 1-360-01-228)
C. T-21 transformer module (W-01 P/N 1-360-03-090) or T-22 transformer module (W-02 P/N 1-360-03-110)
D. Transducer port (meter body)
E. Transformer retainer (P/N 1-360-01-160)
F. Retaining clip
G. Transducer cable:
   - 100°C - 5’ length P/N 1-360-03-232
   - 100°C -15’ length (P/N 1-360-03-233)

9. Apply three wraps of Teflon tape to the retainer. Place over the transformer assembly. Ensure the retainer threads are aligned correctly and hand-tighten. Use a 1 ⅛-in. wrench and turn clockwise until the transformer retainer is fully seated in the transducer holder.

**Note**
Do not over tighten the retainer.

10. Reconnect the transducer cable to retainer. The internal connector of the transducer cable is keyed and will only go on one way. Secure the transducer cable plug by installing retaining clips.

11. Repeat Step 1 through Step 10 for the remaining transducer assemblies which were replaced.

12. Check that the Rosemount 3410 Series Ultrasonic Gas Flow Meter is pressure tight. Pressurize the meter to line pressure. Check for leaks around all mounts and transducer holders, which were removed, using soapy water or other recognized leak detector. If leaks are found, the meter must be vented to atmosphere and the problem corrected. Check for leaks again. Continue the process until there are no leaks.

13. Continue with **Modifying the calibration parameters for T-Slot transducers** to use the MeterLink™ Transducer Swap-out Wizard.
3.2.3 Replace the transformers for T-Slot transducers

The following procedure shows how to replace a transformer module. Refer to Figure 3-2 and Figure 3-4.

Procedure

1. Disconnect the transducer cable from the transducer retainer by removing the retaining clips and pulling the cable plug straight out. Do not twist or rotate the plug.
2. Unscrew the transformer retainer from the holder using a 1 ⅛-in. wrench.
3. Pull the transformer module from the transducer holder assembly.
4. Apply a small amount of Molykote 111 to the O-rings on the replacement transformer module.
5. Plug the replacement transformer module into the transducer holder assembly. The transformer is keyed and can only be installed one way.

Note
T-21 and T-41 transducers use W-01 transformers and T-22 transducers use W-02 transformers.

6. Apply three wraps of Teflon tape to the retainer. Place over the transformer assembly. Ensure the retainer threads are aligned correctly and hand-tighten. Use a 1 ⅛-in. wrench and turn clockwise until the transformer retainer is fully seated in the transducer holder.

Note
Do not over tighten the retainer.

7. Place the transformer retainer over the transformer module. Ensure the retainer threads are aligned correctly and hand-tighten. Use an 1 1/8-in. wrench and turn clockwise until fully seated in the transducer holder.

Note
Do not over tighten the retainer.

8. Plug the keyed cable into the transformer assembly and install retainer clips.

3.2.4 Modifying the calibration parameters for T-Slot transducers

When transducer pairs, mounts, stalks or transducer holders are replaced, the corresponding meter calibration parameters must be updated for accurate operation. This means modifying the affected chord "L" dimension (LA... LD) (see Determining the "L" Value below), average delay time (AvgDlyA... AvgDlyD) and delta delay time (DltDlyA... DltDlyD) using the MeterLink Transducer Swap-out Wizard (see Figure 3-5 in Determining L Value).

Average delay time and delta delay time modifications

The transducer pair average delay time and delta delay time are located on the transducer pair calibration sheet. These values must be downloaded to the appropriate meter data points (AvgDlyA... AvgDlyD, DltDlyA... DltDlyD). The lengths of the transducers are also included on the calibration sheet and are etched on the transducers. Likewise the lengths of the stalk assemblies, transducer holders, and mounts are etched on the individual components. The length of the meter body is found on the original calibration sheet supplied with the meter.
Determining the “L” value

The value “L” is determined by adding the length of the meter body to the lengths of the two mounts and subtracting the lengths of the transducer holders, stalk assemblies, and transducers. This value should be written to the appropriate meter data points for each chord that received new transducers (LA... LD). See Equation 3-1 for the “L” dimension calculation.

Figure 3-5: MeterLink Transducer Swap-out Wizard

Chord “L” dimension calculation

The chord “L” dimension is calculated from the meter housing length as well as the transducer pair lengths, mount lengths, holder lengths, and stalk lengths as shown in Equation 3-1. The transducer lengths are etched on the transducers. Likewise, the lengths of the mounts, stalk assemblies, and transducer holders are also etched on the individual
components. The length of the meter body is found on the original calibration sheet supplied with the meter.

**Equation 3-1: Chord “L” Dimension**

\[
L_{chord} = L_{MeterHousing} + L_{Mount1} + L_{Mount2} - L_{Xdcr1} - L_{Stalk1} - L_{Hldr1} - L_{Xdcr2} - L_{Stalk2} - L_{Hldr2}
\]

- \(L_{chord}\) = chord “L” dimension (in) (LA ... LD)
- \(L_{MeterHousing}\) = meter housing length (in)
- \(L_{Mount1}\) = transducer 1 mount length (in)
- \(L_{Mount2}\) = transducer 2 mount length (in)
- \(L_{Xdcr1}\) = transducer 1 length (in)
- \(L_{Xdcr2}\) = transducer 2 length (in)
- \(L_{Stalk1}\) = transducer 1 stalk length (in)
- \(L_{Stalk2}\) = transducer 2 stalk length (in)
- \(L_{Hldr1}\) = transducer 1 holder length (in)
- \(L_{Hldr2}\) = transducer 2 holder length (in)

**Tip**
The transducer “L” dimension is re-calculated when you run the Transducer Swap-out utility.

### 3.3 T-Slot transducer holder removal and installation

⚠️ **WARNING**

CONTENTS MAY BE UNDER PRESSURE

When the meter is under pressure, DO NOT attempt to remove or adjust the transducer holder of the T-Slot transducer assembly, or loosen the screws holding the T-200 transducer assembly.

Attempting to do so could release pressurize gases, resulting in serious injury or equipment damage.
WARNING

CONTENTS MAY BE HAZARDOUS
The meter must be fully depressurized and drained before attempting to remove the transducer holder of T-Slot transducer assembly, or the T-200 transducer assembly. If gas or fluid begins to leak from the transducer holder of T-Slot transducer assembly, or T-200 transducer stalk assembly, stop immediately and reinstall the transducer holder or T-200 stalk assembly.
Failure to comply could cause serious injury or equipment damage.

A. Transducer holder

WARNING

CUTTING HAZARD
Sharp edges may be present on the transducer retaining ring.
Wear appropriate eye protection equipment when removing or installing the transducer retaining ring.
Failure to comply could cause serious injury.

3.3.1 Remove the T-Slot transducer holder

Rosemount™ 3410 Series Ultrasonic Gas Flow Meters utilize transducer holders that contain the transducer assemblies and act as the pressure barrier between the transducers and the fluid.
Under normal maintenance such as transducer replacement, the transducer holders do not need to be removed. If it is necessary to remove the transducer holders, the following steps detail how to safely remove and reinstall them. Before removing and installing the transducer holder, connect to the meter using MeterLink™ and collect and save a Maintenance Log.

Procedure

1. Blow the line down according to the site standard operating procedures.
2. Ensure that the line pressure is down to atmospheric pressure prior to disassembly.
3. Disconnect the transducer cable by removing the retaining clips and pulling the cable plug straight out. Do not twist or rotate the plug. (See Figure 3-2).

4. Remove the transformer retainer using a 1 ⅛-in. wrench and then disconnect and remove the transformer module (Figure 3-4).

**Note**
T-21 and T-41 transducers use W-01 transformers and T-22 transducers use W-02 transformers.

5. Use a 1 ¼-in (32 mm) wrench on the hex of the transducer holder and slowly unscrew in a counterclockwise direction from the meter. If you hear gas leaking from the threads, immediately stop and reinstall the holder as the meter has not been fully drained and/or pressure has not been relieved from the meter. Correct the issue before attempting to remove the holder.

The transducer holder has now been removed from the meter with the transducer still installed inside the transducer holder.

6. Make a note of the removed transducer holder length which is used to update the meter configuration during the Transducer Swap-out procedure in MeterLink, after all of the transducer holders are replaced.

**Figure 3-6: Transducer holder length and set screw identification**

A. Transducer holder set screws
B. Transducer holder length identification

7. Loosen the three Allen setscrews with a 1/16-in. hex driver securing the transducer assembly and stalk, if installed. Carefully remove the transducer by pulling it from the T-Slot transducer holder (or stalk if installed) without rotating.

8. Clean the holder with a dry cloth.

### 3.3.2 Install the T-Slot transducer holder

**Procedure**

1. Ensure that the Rosemount™ 3410 Series Ultrasonic Gas Flow Meter transducer port, mount, and T-Slot transducer holder assembly are clean and free of debris.
2. Insert the transducer (parts are keyed and can only be assembled one way) into the stalk or into the new transducer holder if no stalk is required. Do not use any lubricant on the O-rings or contacts of the transducers.

**NOTICE**

Ensure that the transducers identified as belonging to end 1 are installed on end 1 of the meter housing and those identified as belonging to end 2 are installed on end 2 of the meter housing.

---

**Figure 3-7: Transducer holder, stalk and transducer assembly**

A. Transducer holder  
B. Stalk  
C. Transducer assembly

3. Replace the O-rings and backup rings on the transducer holder. Make sure the contoured side of the backup ring faces away from the transducer holder. It is highly recommended that the O-rings be replaced when the transducer is removed from the holder/stalk.

4. Use a 1/16-in. hex driver to equally tighten the three Allen set screws on the transducer holder to secure the transducer assembly and the stalks (if installed).

5. Apply a light coat of Molykote 111(1). Silicone grease or equivalent to the transducer holder O-rings.

6. Ensure that the transducer port, mount, and T-Slot transducer assembly are clean and free of debris.

7. Apply a small amount of nickel anti-seize compound (P/N 2-9-9960-134) to the outer threads of the transducer holder.

8. Insert the T-Slot transducer assembly into the meter transducer port. Tighten with crescent wrench to securely seat the assembly in the mount. Do not over tighten.

9. Plug the transformer module into the transducer holder assembly. The transformer module is keyed and can only be installed one way.

10. Apply three wraps of Teflon tape to the retainer. Place over the transformer assembly. Ensure the retainer threads are aligned correctly and hand-tighten. Use a 1 ⅛-in. wrench and turn clockwise until the transformer retainer is fully seated in the transducer holder.

---

(1) *Molykote 111 is a trademark of Dow Corning Corporation, U.S.A.*
11. Place the transformer retainer over the transformer module. Ensure the transformer retainer threads are aligned correctly and hand-tighten. Use an 1 ⅛-in. wrench and turn clockwise until fully seated in the transducer holder.

12. Align the keyed transducer cable and securely seat into the transducer holder and secure with retaining clips.

**Note**
The transducer cable is keyed and will only go on one way.

13. Repeat Step 1 through Step 12 for all transducer holders to be replaced.

14. Slowly repressurize the meter to line pressure. Check for leaks as the meter is pressurized. If you hear gas leaking from the threads, recheck all connections and resolve the problem. Then, slowly repressurize the meter to line pressure.

15. Connect to the meter with MeterLink and update the transducer parameters. From the **Tools → Transducer Swap-out** menu, run the Transducer Swap-out Wizard. This utility allows you to update the parameters for the components that are replaced.

**Note**
Running the Transducer Swap-out utility is required when transducers, mounts, holders, or stalks are replaced for a chord.

a) After writing all of the changes to the meter’s configuration, open the Monitor (Detailed View) and verify the meter is acquiring data, the transducers have good signals and flow profiles for the all of the chords displayed.

b) Collect and save a Maintenance Log and verify the meter is optimally performing. Save the meter configuration file. If communicating with the meter via Modbus or HART, manually update the parameters (see **Modifying the calibration parameters for T-Slot transducers**).

### 3.4 T-200 transducer assembly removal and installation

**WARNING**

CONTENTS MAY BE HAZARDOUS

The meter must be fully depressurized and drained before attempting to remove the T-200 transducer assembly. If gas or fluid begins to leak, stop immediately and reinstall the transducer assembly.

Failure to comply could cause serious injury or equipment damage.
T-200 transducer assembly (see Figure 3-8) offers improved transducer alignment and superior acoustic isolation between the transducer and the meter housing. The net result is improved performance and stability. The assembly can be used on 4” to 12” Rosemount™ 3410 Series meters. The gas temperature ranges are as show in Table 3-1.

### 3.4.1 T-200 transducer assembly removal

This procedure is for removing a T-200 transducer assembly from a meter body.
Procedure

1. Blow the line down according to the site standard operating procedures.
2. Ensure that the line pressure is down to atmospheric pressure prior to disassembly.
3. Disconnect transducer cabling from the transducer assembly by removing the retaining clips and pulling the cable plug straight out. Do not twist or rotate the plug.
4. If the transducer housing is planned to be serviced or replaced, loosen the transducer retainer one quarter turn by turning the retainer counter-clockwise with a 1 ⅛-in. wrench. DO NOT remove the transducer retainer at this time.
5. Remove the four or six ⅜-in. cap screws holding the T-200 transducer assembly on the meter body.
6. Carefully pull the T-200 transducer assembly out of port hole without damaging the transducer housing.
7. Mark the port number, i.e. A1, ... D2, on the transducer stalk if not labeled already. Place the T-200 transducer assembly in a safe place to avoid any damages to the assembly.
8. Place the T-200 transducer assembly in a safe place to avoid any damages to the assembly.
3.4.2 T-200 transducer assembly installation

This procedure is for installing a T-200 transducer assembly on a meter body.

Procedure

1. Check the label marked on the stalk or the serial number on the stalk assembly to match the intended port number on the meter body.
2. Record the lengths of T-200 transducer housing, spacer and stalk assembly that come with the transducer assembly calibration sheet.
3. Make sure the O-ring and backup ring on the transducer stalk are clean and properly installed. Apply a (light) coat of D.C. 111 to the O-ring.
4. Carefully insert the transducer assembly into the port hole without damaging the transducer housing or port hole. Make sure the serial number is facing the top.
5. Use four or six ⅜-in. cap screws to install the transducer assembly. Tighten the cap screws in a criss-cross pattern so they are tightened evenly. Torque the ⅜-in. cap screws to 35 ft. lbs.
6. If the transducer retainer has been hand-tightened after servicing or replacing the transducer housing, use a 1 ⅛-in. wrench to bottom out the transducer retainer on the stalk. DO NOT torque down the transducer retainer to avoid damages to the anti-rotation pins.
7. Align the keyed transducer cable plug and securely seat into the transducer retainer, and secure with retaining clips.

3.4.3 Modifying the calibration parameters for T-200 transducers

When T-200 transducer pairs, housings or stalks are replaced, the corresponding meter calibration parameters must be updated for accurate operation. This means modifying the affected chord "L" dimension (LA... LD) (see Determining the "L" Value below), average delay time (AvgDlyA... AvgDlyD) and delta delay time (DltDlyA... DltDlyD) using the MeterLink Transducer Swap-out Wizard (see Figure 3-5).

Generally, there are three types of situations that require updating delay times or both delay times and length "L":

- **Replacing T-200 transducer capsules only**: need to update delta delay time only. No change in length "L".
- **Replacing T-200 transducer capsules and housings**: need to update average and delta delay times, and length "L".
- **Replacing full T-200 transducer assemblies, including capsules, housings and stalks**: need to update average and delta delay times, and length "L".

Procedure

1. Update average delay time and delta delay time. The transducer pair average delay time and delta delay time are located on the transducer pair calibration sheet. These values must be downloaded to the appropriate meter data points (AvgDlyA... AvgDlyD, DltDlyA... DltDlyD).
2. Update the chord lengths "L" of the transducers. The lengths of transducer assembly and individual components, including housing, spacer and stalk, are included on the calibration sheet and are etched on the transducer housings, spacers and stalks. The length of the meter body is found on the original calibration sheet supplied with the meter. The value "L" is determined by subtracting the lengths of the transducer stalks, spacers and housings from the length of the meter body.
3. Chord length "L" Calculation. The chord length “L” is calculated from the meter length as well as the lengths of transducer stalks, spacers and housings as shown in the following equation.

**Equation 3-2: Chord "L" Dimension for T-200 transducer assemblies**

\[
L_{\text{chord}} = L_{\text{Meter Housing}} - L_{\text{Stalk 1}} - L_{\text{Spacer 1}} - L_{\text{Housing 1}} - L_{\text{Stalk 2}} - L_{\text{Spacer 2}}
\]

where

- \( L_{\text{chord}} \) = chord “L” dimension (in) (LA...LD)
- \( L_{\text{Meter Housing}} \) = meter housing length (in)
- \( L_{\text{Stalk 1}} \) = transducer 1 stalk length (in)
- \( L_{\text{Stalk 2}} \) = transducer 2 stalk length (in)
- \( L_{\text{Spacer 1}} \) = transducer 1 spacer length (in)
- \( L_{\text{Spacer 2}} \) = transducer 2 spacer length (in)
- \( L_{\text{Housing 1}} \) = transducer 1 housing length (in)
- \( L_{\text{Housing 2}} \) = transducer 2 housing length (in)

### 3.5 T-200 transducer capsule assembly removal and installation

**Figure 3-10: T-200 transducer capsule assembly**

T-200 transducer capsule assembly (see Figure 3-10) can be removed or installed while the line is pressurized or at atmospheric pressure.

#### 3.5.1 T-200 transducer capsule assembly removal

This procedure is for removing a transducer capsule assembly from a T-200 transducer assembly installed in a meter body. The line can be pressurized or at atmospheric pressure.

**Procedure**

1. Disconnect transducer cabling and chordset from the T-200 transducer assembly by turning the cable nut counter-clock wise.
2. Disconnect the transducer cable nut. Pull the chordset from the transducer assembly.
3. Remove the transducer retainer from the transducer stalk by turning the retainer counter-clock wise with a 1 ⅛-in. wrench.

4. Hold the transducer capsule assembly and carefully pull it out of the transducer stalk.

**Note**  
Do not remove the Kapton tape on the top of the transducer capsule assembly.

5. Use non-fiber paper to remove any residue of acoustic coupling fluid on the surface of Kapton tape.

6. Record the serial number of the removed transducer capsule assembly and put it in a safe place.

7. Repeat Step 1 to Step 6 if more transducer capsule assemblies are to be removed.

### 3.5.2 T-200 transducer capsule assembly installation

This procedure is for installing a transducer capsule assembly into a transducer assembly while it is installed in a meter body.

**Procedure**

1. Ensure that the transducer stalk, retainer and capsule assembly are clean and free of debris.

2. Record the serial number of the transducer capsule assembly to be installed and make sure it is correct for the intended transducer assembly.

**Table 3-2: T-200 transducer stalk assembly configuration and capsule setting**

<table>
<thead>
<tr>
<th>Stalk assembly configuration</th>
<th>Smart capsule setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>-01</td>
<td>1</td>
</tr>
<tr>
<td>-02</td>
<td>2</td>
</tr>
<tr>
<td>-03</td>
<td>3</td>
</tr>
<tr>
<td>-04</td>
<td>4</td>
</tr>
<tr>
<td>-05</td>
<td>5</td>
</tr>
<tr>
<td>-06</td>
<td>1</td>
</tr>
<tr>
<td>-07</td>
<td>2</td>
</tr>
<tr>
<td>-08</td>
<td>3</td>
</tr>
<tr>
<td>-09</td>
<td>4</td>
</tr>
<tr>
<td>-10</td>
<td>5</td>
</tr>
<tr>
<td>-11</td>
<td>6</td>
</tr>
<tr>
<td>-12</td>
<td>7</td>
</tr>
<tr>
<td>-13</td>
<td>8</td>
</tr>
</tbody>
</table>
3. Ensure that the setting of the transducer capsule assembly matches the stalk assembly configuration (see Table 3-2). The setting of a transducer capsule assembly is indicated by the number next to the slot where the tap is located (see Figure 3-11), i.e. 1, 2, ... 8. The stalk assembly configuration is labeled on the transducer stalk, next to its serial number (see Figure 3-12), i.e. -01, -02, ... -13 after "T-200". If adjustment is needed:
a) Use one hand to hold the crystal holder and the other hand to hold the transformer housing (see Figure 1).

b) Turn the transformer housing clockwise by 90 degrees and slide it slowly to align the tab to the proper position according to Table 3-2.

c) Turn the transformer housing counter-clockwise by 90° to let the tab snap into the correct slot. Ensure the tab is secured in the slot.

4. Hold the transducer capsule assembly vertically and apply a small amount of Acoustic Coupling Fluid (P/N: 1-360-01-650) to the surface of Kapton tape.

5. Carefully spread the coupling fluid on the surface of Kapton tape using the tip of the plastic bottle for the coupling fluid.

**Note**
Do not press the Kapton tape while spreading the coupling fluid.

6. Wait for 30 - 60 seconds to let the coupling fluid spread more evenly on the surface.

7. Insert the transducer capsule assembly into the transducer stalk while aligning the anti-rotation pin on the capsule with the slot on the inner surface of the stalk.

**Figure 3-13: Length verification of T-200 transducer capsule assembly**

A. Transducer stalk
B. Indicator ring
C. Capsule assembly

8. Make sure that the indicator ring on the transducer capsule assembly is flush with the end of the transducer stalk (see Figure 3-13) to ensure the capsule is set to the correct length.

9. Screw the transducer retainer on the stalk and use a 1 ¼-in. wrench to bottom out.

**Note**
Do not torque down the transducer retainer to avoid damages to the anti-rotation pins.
10. Connect the transducer chordset to the transducer retainer. The internal connector of the transducer chordset is keyed and will only go on one way.

11. Secure the transducer cabling nut by turning clock wise. Ensure the cable nut threads are correctly aligned.

12. Repeat Step 1 through Step 11 for other transducer assemblies if their transducer capsule assemblies were replaced.

13. Continue with Modifying the calibration parameters for T-Slot transducers to use the MeterLink Transducer Swap-out Wizard to update delta delay time.

### 3.6 T-200 transducer housing removal and installation

**WARNING**

CONTENTS MAY BE HAZARDOUS
The meter must be fully depressurized and drained before attempting to remove the T-200 transducer assembly. If gas or fluid begins to leak, stop immediately and reinstall the transducer assembly.

Failure to comply could cause serious injury or equipment damage.

---

**Figure 3-14: Components of T-200 transducer assembly**

<table>
<thead>
<tr>
<th>Retaining Ring</th>
<th>Washer</th>
<th>Wave Spring</th>
<th>Transducer Housing</th>
<th>Spacer</th>
<th>Transducer Stalk Assembly</th>
<th>Transducer Retainer</th>
</tr>
</thead>
</table>

---

#### 3.6.1 T-200 transducer housing removal

This procedure is for removing a transducer housing from a T-200 transducer assembly installed in a meter body.

**Procedure**

1. Follow T-200 transducer assembly removal to remove the transducer assembly from the meter body first. Ensure that the line pressure is down to atmospheric pressure prior to disassembly.
2. Hold the T-200 transducer assembly vertically with the transducer retainer facing up.
3. Remove the transducer retainer from the stalk. Do not drop the transducer capsule.
4. Carefully pull the transducer capsule out of the stalk and place it in a safe place.
5. Hold the transducer stalk vertically with the transducer housing facing up.
6. Place the housing removal tool on the top of the transducer housing.
7. Press the tool down while using a flat-head screw driver to release the retaining ring (see Figure 1).

**Note**  
Do not lose the retaining ring that will be popped up by the wave spring.

8. Remove the washer and wave spring from the transducer housing.
9. Remove the transducer housing from the stalk.
10. Place the stalk upward on a flat table and do not lose the PAI spacer inside the stalk.

### 3.6.2 T-200 transducer housing installation

This procedure is for installing a T-200 transducer housing into a transducer stalk and restoring the transducer assembly in a meter body.

**Procedure**

1. Clean the transducer housing and the transducer stalk.
2. Replace the two O-rings on the transducer housing and apply a small amount of Molykote 111 to the O-rings.
3. Make sure the PAI spacer is inside the stalk.
4. Slowly insert the transducer housing into the stalk until the housing is seated flat against the PAI spacer.
5. Put the wave spring over the housing.
6. Put the washer over the housing.
7. Put the retaining ring on the top of the washer.
8. Press down the housing removal tool while securing the retaining ring.

**WARNING**

Ensure that the retaining ring is fully engaged into the slot to prevent unintended ejection during meter operation.

9. Ensure that the transducer stalk, retainer and capsule are clean and free of debris.
10. Record the serial number of the transducer capsule to be installed and make sure it is correct for the intended transducer assembly.
11. Ensure that the setting of the transducer capsule matches the stalk assembly configuration (see Table 3-2). The setting of a transducer capsule is indicated by the number next to the slot where the tap is located (see Figure 3-11), i.e. 1, 2, ... 8. The stalk assembly configuration is labeled on the stalk (see Figure 3-12), next to its serial number, i.e. -01, -02, ... -13. If adjustment is needed:
   a) Use one hand to hold the top piece of the capsule and the other hand to hold the bottom piece of the capsule.
   b) Turn the bottom piece clock wise by 90° and slide it inside the top piece to proper position according to Table 3-2.
   c) Turn the bottom piece counter-clock wise by 90° to let the tap snap into the correct slot. Make sure the tap is secured in the slot.
12. Hold transducer capsule vertically and apply a small amount of Acoustic Coupling Fluid (P/N: 1-360-01-650) to the surface of Kapton tape.
13. Carefully spread the coupling fluid on the surface using the tip of the plastic bottle for the coupling fluid.

**Note**
Try to avoid pressing the Kapton tape while spreading the coupling fluid.

14. Wait for 30 - 60 seconds to let the coupling fluid spread more evenly on the surface.
15. Insert the transducer capsule into the transducer stalk while aligning the anti-rotation pin on the capsule with the slot on the inner surface of the stalk.
16. Make sure that the indicator ring on the transducer capsule is flush with the end of the transducer stalk to ensure the capsule is set to the correct length (see Table 3-2).
17. Hand-tighten the transducer retainer onto the stalk.
18. Follow T-200 transducer housing installation to install the transducer assembly in a meter body.

### 3.7 Transducer cable removal and installation

Rosemount 3410 Series Ultrasonic Gas Flow Meters have red transducer cables that plug directly in the back of the transformer retainer.

**Note**
Make a note of the exiting cabling path layout to allow proper tie-wrap configuration later in this procedure.

![Rosemount 3410 Series Ultrasonic Gas Flow Meter transducer cables and ports](image)

A. Cable ties
B. Rosemount 3410 Series Ultrasonic Meter transducer port
C. Transducer assembly
3.7.1 Replace transducer cables

The meter body ports are identified by stamped or cast lettering adjacent to the transducer port. Transducers for transmitter head 1 will be labeled 1-A1, 1-A2, etc. while the transducer for transmitter head 2 will be labeled 2-A1, 2-A2, etc.

Procedure

1. Remove power to the meter.
2. Disconnect the transducer cable from the transformer retainer by removing the retaining clips and pulling the cable plug straight out. Do not twist or rotate the plug. (See Figure 3-2.)
3. Cut the tie wraps for the transducer cable you are replacing.
4. Remove the four bolts holding the Base Enclosure cover to the Transmitter Electronics Enclosure using a 6 mm Allen wrench.
5. Lift the Transmitter Electronics Enclosure from the Base Enclosure. It may be necessary to remove the ground lug wire and loosen the conduit connections prior to removal.
6. Carefully prop the Transmitter Electronics Enclosure to the side.
7. Use a flat-blade screw driver and disconnect all the plugs from the Acquisition module. (See Figure 3-16.)
8. Loosen the three screws that mount the Acquisition Module into the base enclosure and remove the Acquisition module.
9. Loosen the thumb screws and remove the cable covers below the electronics mounting bracket.
10. Unscrew the transducer cable to be replaced from the Acquisition module plug.
11. To avoid having to remove the electronics mounting bracket, it is recommended to cut the plug off the end of the old transducer cable and attach the end of the new transducer cable to it with tape or by wrapping the discrete wires together. The new transducer cable can then be pulled up and through the electronics mounting bracket.
12. Disconnect the new transducer cable from the old transducer cable. Finish removing the old cable by pulling it through the base enclosure gasket. The new cable can then be pushed through the base enclosure gasket.
13. Make sure the new transducer cable is routed properly and then cut off excess length. Strip the individual wires ¼-in. and install wire ferrules. Screw wires into the Acquisition module plug.
14. Reinstall the Acquisition modules and securely tighten the plugs back to the module.
15. Place the transmitter head back on the base enclosure and secure it with the four bolts.
16. Reinstall the cable covers under the electronics bracket and secure by tightening the thumb screws.
17. Reinstall the shroud covers over the transducers and wire seal if necessary.
18. Reattach the external ground wire to the ground lug and power up the meter.

**Figure 3-16: Model 3410 Ultrasonic Meter Acquisition Module Wiring**

---

### 3.7.2 Install transducer cables

**Procedure**

1. Use the existing cable and cut the new cable (P/N 1-360-01-310) for each cable to same length.
2. Insert the keyed cable into the transducer holder. Make sure the keyed parts are correctly aligned.
3. Screw the cable nut onto the transducer holder turning clock-wise until hand-tight. Ensure the threads are correctly aligned and do not overtighten the cable nut.
4. Route the cable through the gland on the Base Enclosure and pull the cable up through the Base Enclosure to allow enough slack to strip the cable wire.
5. Strip the outer insulation, outer shield, and inner insulation to just inside the cable gland using a wire stripper.
   a) Verify that insulation of individual wires were not cut while removing outer layers.
   b) Strip each wire ¼-in. and wire them to the Acquisition Module terminal block.
   c) Check the label number (i.e. A1) on the Acquisition Module and match it with the label on the cable. Securely tighten the mounting screws of terminal block J1 and J2 as shown in **Figure 3-17 Ultrasonic Meter Acquisition Module wiring**.
6. Only connect wires for Chords A1, A2, B1 and B2 for 3416 and 3417 meter applications or A1 and A2 for 3415 meter applications. The relative position of the contacts is shown on the Acquisition Module label adjacent to the terminal block.
   a) When terminating the connector wires, ensure that the contacts clamp on the bare wires and not on the wire insulation.
   b) Leave the connector plugged into the Acquisition Module while terminating the individual wires.

7. Tighten the cable gland once the transducers are wired correctly, so that the transducer cable is held securely in place. Pull the cable back through the gland to remove the slack and configure the cable to follow the same path of the existing cable (see Figure 3-17) and note in Transducer cable removal and installation.

8. Repeat Step 1 through Step 7 if you are replacing other cables.

9. Once all of the cables are replaced, dress with tie wraps (P/N 2-4-9158-001) in groups of two. Once all of the cables are replaced; A1 and C1, D1 and B1, A2 and C2, D2 and B2. Install one cable tie three inches from the Base Enclosure and another near the point the cables start to bend and separate out into their respective port (see Figure 3-17).

10. Inspect the Transmitter Electronics Enclosure gasket for wear and replace it if necessary.

11. Lubricate it with Molykote 111(2) (P/N 2-9-9960-135) if replacing the gasket.

---

(2) Molykote 111 is a trademark of Dow Corning Corporation, U.S.A.
12. Prop the Transmitter Electronics Enclosure at an angle on top of the Base Enclosure.

13. Plug the Acquisition cable terminal block to J3 on the Acquisition Module. Use a flat blade screwdriver and securely tighten the terminal block mounting screws to the Acquisition Module.

14. Wrap the excess cable around the Acquisition Module below the lip of the Base Enclosure (this prevents pinching the cable when the Transmitter Electronics Enclosure is installed).

15. Attach one desiccant pack to the underside of the Base Enclosure cover.

16. Place the Transmitter Electronics Enclosure onto the Base Enclosure. Rotate the Transmitter Electronics Enclosure until the mounting holes are correctly aligned with the holes in the Base Enclosure.

17. Install the two hex head bolts with a 6 mm Allen wrench to secure the Transmitter Electronics Enclosure to the Base Enclosure.

18. Reattach the external ground wire to the ground lug, reconnect the conduit, and power the meter.

19. If required, install the security seal wire into and through one of the two holes in the end cap. Choose holes that minimize counterclockwise rotation of the end cap when the security wire is taut (maximum wire diameter 0.078 inch; 2.0 mm).

20. Adjust the security wire, removing all slack and thread into the lead seal.

21. Cut wire ends to remove excess wire.

22. If required, attach the security wire seals on the Base Enclosure.

--

**Figure 3-18: Transmitter Electronics Enclosure security seals**

A. Transmitter electronics enclosure endcap
   B. Security seals
Figure 3-19: Meter with and without security shrouds

A. Transducer cable nut, cable and security seal
B. Security shrouds

23. Twist and adjust wire removing all slack and seal. Remove excess wire.
24. If required by the site operations manager, have an electrician fully test the connections. After the Acceptance Test is witnessed and approved, seal the conduit.
25. Power down the system and apply the sealing compound to the conduit and allow to set in accordance with manufacturer specifications.
26. Twist and adjust wire removing all slack and seal. Remove excess wire (see Figure 3-20).

27. If required by the site operations manager, have an electrician fully test the connections. After the Acceptance Test is witnessed and approved, seal the conduit.

28. Power down the system and apply the sealing compound to the conduit and allow to set in accordance with manufacturer specifications.

3.8 Replace the meter electronics

The following procedure should be performed by a qualified service technician or trained personnel. Observe all warning labels on the meter before starting this procedure.

The Rosemount 3410 Series Gas Ultrasonic Flow Meter Transmitter Electronics Enclosure consists of the following:

- CPU Module assembly (P/N 1-360-03-010)
- Optional I/O module (RS-232 or RS-485)
- Expansion I/O module
- I.S. Barrier Board (P/N 360-03-004)
- Power Supply (P/N 360-03-003)
- Backplane Board (P/N 360-03-007)

The Rosemount 3410 Series Gas Ultrasonic Flow Meter Base Enclosure consists of the following:

- Acquisition Module (P/N 1-360-03-008) (T-21, T-22, T-41, T-200)
- Transducer Cable (5FT P/N 1-360-03-232, 15FT P/N 1-360-03-233)
Should the Rosemount 3410 Series Ultrasonic Gas Flow Meter require disassembly in the field (i.e., check boards, change switch settings, or replace boards), to prevent electrostatic damage to the electronic boards, always use a ground strap while handling the circuit boards. If one is not available, ensure you are electrically discharged before touching the boards by first touching a metal surface such as a ground lug on the meter or a table.

**Figure 3-21: 3410 Series electronics**

A. Terminal end of Transmitter Electronics Enclosure
B. Backplane board location
C. End cap security latch
D. Base enclosure with Acquisition Module

### 3.8.1 Replace CPU module or Optional I/O module

**Procedure**

1. Remove power to the meter.
2. Disconnect security seals on the Transmitter Electronics Enclosure (see Figure 3-18), loosen the end cap security latches using a 3 mm Allen wrench (see Figure 3-17) and remove end cap from the terminal end of the Transmitter Electronics Enclosure.
3. Disconnect the CPU Module terminal blocks (or the optional I/O Module terminal blocks) if replacing the CPU Module (terminal end of the enclosure) or the Optional I/O Module.
4. Grasp the outer ends of the module you want to replace and pull it out of the enclosure.
5. Insert the new CPU Module or I/O Module into the enclosure and firmly push until the board is fully seated into the Backplane Board connectors and the lock is engaged.
6. Replace the terminal blocks for the CPU Module and/or the Optional I/O Module and verify the tightness of the terminals with a 3 mm flat blade screw driver.

**Important**
If changing from Type 2 to Type 4 CPU, note wiring changes required for AO2 and Group 2 Outputs.

7. If you are not replacing other electronics, replace the end cap and security latches (requires a 3 mm Allen wrench). If required, install the security seal wire into and through one of the two holes in the end cap.
   a) Choose holes that minimize counterclockwise through one of the two holes in the end cap.
   b) Choose holes that minimize counterclockwise rotation of the end cap when the security wire is taut (maximum wire diameter 0.078-in.; 2.0 mm).

---

**Figure 3-24: Transmitter electronic enclosure security seals**

![Image of Transmitter electronic enclosure security seals]

A. Transmitter Electronics Enclosure end cap
B. Security wire seals

8. Adjust the security wire, removing all slack and thread into the lead seal.
9. Cut wire ends to remove excess wire.
10. If replacing other electronics or the fuse, continue with Fuse replacement, Backplane replacement, I.S. Barrier Board replacement or Power Supply Board replacement and Acquisition Module replacement before replacing the end caps and sealing the enclosure.
11. If you encounter problems replacing the electronics, see the Flow Lifecycle Services contact information on the front cover of this manual.
   This completes the CPU Module or I/O Module replacement procedure.
3.8.2 Fuse replacement

Procedure

1. Remove power to the meter.
2. Disconnect the Transmitter Electronics Enclosure security seals (see Figure 3-24), loosen the end cap security latch (requires a 3 mm Allen wrench) on the terminal end of the enclosure (see Figure 3-21) and remove the end cap.
3. Insert the replacement fuse (Littlefuse #218002.HXP) into the Fuse Holder.
4. Install the fuse cap into the holder and push until it is flush with the holder.
5. Turn the fuse cap clockwise ⅛ turn using a ¼-in. standard flat head screwdriver.
6. Replace the end cap and security latch (requires a 3 mm Allen wrench).
   a) If required, install the security seal wire into and (requires a 3 mm Allen wrench).
   b) If required, install the security seal wire into and through one of the two holes in the end cap.
   c) Choose holes that minimize counterclockwise rotation of the end cap when the security wire is taut (maximum wire diameter 0.078-in.; 2.0 mm) (see Figure 3-24).
7. Adjust the security wire, removing all slack and thread into the lead seal.
8. Cut wire ends to remove excess wire.
9. Apply power to the meter.
   This completes the fuse replacement procedure.

3.8.3 Replace Backplane, I.S. Barrier or Power Supply board

The following sections detail removal of the Backplane board, the I.S. Barrier Board and the Power Supply Board.

Backplane replacement

Procedure

1. If replacing the Backplane board, remove power to the meter.
2. Disconnect the Transmitter Electronics Enclosure security seals, loosen the end cap security latches (3 mm Allen wrench required) and remove both end caps (see Figure 3-24).
3. Remove the CPU Module and the Optional I/O Module (if installed). See Figure 3-22 for board locations and associated terminal blocks.
4. Use a Phillips head screwdriver and remove the four Backplane board screws and captive star washers from the enclosure standoffs.
5. Pull the Backplane board out of the enclosure. This disconnects the I.S. Barrier Board. Lay the Backplane board down with the Acquisition Cable still attached (the Power Supply board may remain attached to the Backplane when you remove it from the enclosure).
Figure 3-25: Backplane board replacement

6. Use a 3 mm flat head screw driver and disconnect the Acquisition Cable terminal block from the Backplane. Unplug the Acquisition Cable from the Backplane.

7. Remove the Power Supply (if it was not removed with the Backplane board) and I.S. Barrier boards from the enclosure. The I.S. Barrier Board has a notched tab that secures the board to the Guide Plate.

8. Attach the Acquisition Cable terminal block to the new Backplane Board and plug the Power Supply Board and I.S. Barrier board into the Backplane board.

9. Insert the Backplane (with the Power Supply and I.S. Barrier Boards attached to the Backplane) into the enclosure.

10. Fully seat the CPU Module and Optional I/O Module onto the Backplane board.

11. Install the four Phillips head screws to secure the Backplane to the enclosure standoffs.

12. Reinstall the terminal blocks on the CPU Module, Optional I/O Module (if installed), and the Power Supply board using a 3 mm flat head screw driver.

**NOTICE**

Ensure the terminal blocks are aligned with the Guide Plate openings.

13. Recheck the connections, wiring and switch settings before replacing the end caps.
14. If replacing other electronics, continue with the following sections before replacing the end caps and sealing the enclosure.

15. If you are not replacing other electronics, replace the end caps, security latches, reseal the meter and apply power. If required, install the security seal wire into and through one of the two holes in the end cap. Choose holes that minimize counterclockwise rotation of the end cap when the security wire is taut (maximum wire diameter 0.078-in.; 2.0 mm) (see Figure 3-24).

16. Adjust the security wire, removing all slack and thread into the lead seal.

17. Cut wire ends to remove excess wire.

18. Apply power to the meter.

This completes the Backplane Board replacement procedure.

If you encounter problems with this procedure, see the Flow Lifecycle Services for Rosemount™ products contact information on the front cover of this manual.

I.S. Barrier Board replacement

Procedure

1. If replacing the I.S. Barrier board, remove power to the meter.

2. Disconnect the Transmitter Electronics Enclosure security seals, loosen the end cap security latches with a 3mm Allen wrench and remove both end caps (see Figure 3-27).

3. Use a 3 mm flat head screw driver and remove the terminal blocks from the Power Supply board, the CPU Module and the Optional I/O Module (if installed). See Figure 3-22 for board locations and associated terminal blocks.

4. Use a Phillips head screw driver and remove the four Backplane board screws from the enclosure standoffs. If the Local Display Module is installed on the Backplane, use a flat blade screw driver and remove the four flat-head screws from the standoffs.

5. Pull the Backplane board out of the enclosure. This disconnects the I.S. Barrier Board. Lay the Backplane board down with the Acquisition Cable still attached (the Power Supply board may remain attached to the Backplane when you remove it from the enclosure).
Figure 3-26: I.S. Barrier board replacement

6. Remove the I.S. Barrier Board from the Guide Plate on the right side of the enclosure.
7. Install the new I.S. Barrier board onto the Backplane Board and seat the Power Supply board onto the Backplane board.
8. Insert the Backplane, I.S. Barrier board and the Power Supply Board into the enclosure.
9. Fully seat the CPU Module and Optional I/O Module onto the Backplane Board.
10. Attach the Backplane to the enclosure standoffs with the four Phillips head screws. If the Local Display Module is installed on the Backplane, use a flat blade screw driver and install the four flat-head screws into the enclosure standoffs.
11. Reinstall the J7 terminal block, if removed, on the Backplane board. Re-install the CPU Module, Optional I/O Module (if installed) and the Power Supply.
12. Recheck the connections, wiring and switch settings before replacing the end caps.
13. If replacing other electronics, continue with the following procedures before replacing the end caps and sealing the enclosure.
14. If you are not replacing other electronics, replace the end caps and security latches (3 mm Allen wrench required).
   a) If required, install the security seal wire into and through one of the two holes in the end cap.
b) Choose holes that minimize counterclockwise rotation of the end cap when the security wire is taut (maximum wire diameter 0.078-in.; 2.0 mm).

Figure 3-27: Transmitter electronics enclosure security seals

A. Transmitter Electronics Enclosure end cap
B. Security wire seals

15. Adjust the security wire, removing all slack and thread into the lead seal.
16. Cut wire ends to remove excess wire.
17. Apply power to the meter.
   This completes the I.S. Barrier Board replacement procedure.
   If you encounter problems with this procedure, see Flow Lifecycle Services for Rosemount™ products contact information on the front cover of this manual.

**Power Supply Board replacement**

**Procedure**

1. If replacing the Power Supply board remove power to the meter.
2. Disconnect the Transmitter Electronics Enclosure security seals, loosen the end cap security latches with a 3 mm Allen wrench and remove both end caps (see Figure 3-27).
3. Use a flat head screw driver and remove the terminal blocks from the Power Supply board, the CPU Module and the Optional I/O Module (if installed). See Figure 3-22 for board locations and associated terminal blocks.
4. Use a Phillips head screw driver and remove the four Backplane board screws from the enclosure standoffs. If the Local Display Module is installed on the Backplane, use a flat blade screw driver and install the four flat-head screws into the enclosure standoffs.
5. Pull the Backplane board out of the enclosure. This disconnects the I.S. Barrier Board. Lay the Backplane board down with the Acquisition Cable still attached (the Power Supply board may remain attached to the Backplane when you remove it from the enclosure).

6. Plug the new Power Supply board and the I.S. Barrier Board onto the Backplane Board.

7. Insert the Backplane, I.S. Barrier board and the Power Supply Board into the enclosure and fully seat the CPU Module and Optional I/O Module.

8. Attach the Backplane to the enclosure standoffs with the four Phillips head screws. If the Local Display Module is installed on the Backplane, use a flat blade screw driver and install the four flat-head screws into the enclosure standoffs.

9. Use a flat blade screw driver and install the terminal blocks on the CPU Module, Optional I/O Module, I.S. Barrier Board and the Power Supply.

10. Recheck the connections, wiring and switch settings before replacing the end caps.

11. If replacing other electronics, continue with Acquisition Module replacement before replacing the end caps and sealing the enclosure.

12. If you are not replacing other electronics, replace the Transmitter Electronics Enclosure end caps, install the end cap security latches (3 mm Allen wrench required).
   a) If required, install the security seal wire into and through one of the two holes in the end cap.
b) Choose holes that minimize counterclockwise rotation of the end cap when the security wire is taut (maximum wire diameter 0.078-in.; 2.0 mm) (see Figure 3-28).

13. Apply power to the meter.
   This completes the Power Supply Board replacement procedure.
   If you encounter problems with this procedure, see the Flow Lifecycle Services for Rosemount™ products contact information on the front cover of this manual.

3.9 Acquisition Module replacement

⚠️ WARNING

CRUSHING HAZARD
During meter installation or removal, always place the unit on a stable platform or surface that supports its assembled weight.
Failure to comply could allow the meter to roll, resulting in serious injury or equipment damage.

Procedure

1. Remove power to the meter.
2. If the installation has rigid conduit, use a medium size crescent wrench and loosen the hex nuts on the Transmitter Electronics Enclosure. This should allow enough slack to remove the Transmitter Electronics Enclosure from the Base Enclosure. If the installation uses flexible conduit, you may not need to disconnect it from the Transmitter Electronics Enclosure.

Figure 3-29: Conduit removal

A. Transmitter electronics enclosure
B. Conduit nuts
3. If the meter is equipped with security seals, remove the seals from the bolts on the Base Enclosure.

Figure 3-30: Transmitter Electronics Enclosure and Base Enclosure security seal removal

A. Transmitter electronics enclosure
B. Base enclosure bolts and security seals

4. Use a 6 mm Allen wrench and remove the four hex head bolts securing the Transmitter Electronics Enclosure to the Base Enclosure.
Figure 3-31: Transmitter Electronics Enclosure removal

A. Transmitter electronics enclosure
B. Base enclosure bolts
C. Base enclosure

5. Use a 3 mm flat head screw driver and disconnect the Acquisition cable terminal block and the transducer wire terminal blocks from the Acquisition Module inside of the Base enclosure.
6. Remove the three Acquisition Module flat head screws and split lock washers, then remove the Acquisition Module from the Base Enclosure.

7. Insert the new Acquisition Module into the Base Enclosure and secure with the three split lock washers and flat head screws.

8. Reattach the terminal blocks onto the Acquisition Module (3 mm flat head screw driver required). Ensure the transducer wires have good contact with the terminal block and the terminal block screws are tight.

9. When you have completed attaching the Transducer wire terminal blocks and the Acquisition cable terminal block to the Acquisition Module, check the Base Enclosure o-ring and reinstall if necessary.

10. Reattach the Transmitter Electronics Enclosure to the Base Enclosure with the four hex head bolts and lock washers. Tighten bolts with a 6mm Allen wrench.

**NOTICE**

Ensure the transducer cables are labeled for the chord configuration.
11. Retighten or reattach the conduit to the Transmitter Electronics Enclosure using a crescent wrench or channel lock pliers.

12. If required, install security wire seal into and through the hole in the socket head screw on the Base Enclosure cover (maximum wire diameter 0.078 inch; 2.0mm).

**Figure 3-33: Base Enclosure wire seal installation**

A. Base Enclosure cover  
B. Security wire seals (optional)

13. Position the wire to prevent counterclockwise rotation of the screws when the seal wire is taut.

14. Feed the security wire beneath the Transmitter Electronics Enclosure and through the adjacent socket head screw. Twist the wire, removing all slack and seal.
Figure 3-34: Base Enclosure security seals

A. Transmitter Electronics Enclosure
B. Transmitter Electronics endcap security latch
C. Security wire seals (optional)
D. Base Enclosure

15. Cut wire ends to remove excess wire.
16. Apply conduit sealing compound according to manufacturer's recommendations.
17. Apply power to the meter.
   This completes the Acquisition Module replacement procedure.
### Conversion factors

#### A.1 Conversion factors per units of measurement

The following table includes conversion factors for many of the Metric and U.S. Customary units of measure used with Rosemount™ 3410 Series Ultrasonic Gas Flow Meters and MeterLink™.

**Table A-1: Conversion factors per units of measurement**

<table>
<thead>
<tr>
<th>Conversion factors</th>
<th>Unit of measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>((^\circ F - 32) \times \frac{5}{9}) -&gt; °C</td>
<td>(K/°C)</td>
</tr>
<tr>
<td>(\frac{5}{9})</td>
<td>(^\circ C/^\circ F)</td>
</tr>
<tr>
<td>(10^{-6})</td>
<td>MPa/Pa</td>
</tr>
<tr>
<td>0.006894757</td>
<td>MPa/psi</td>
</tr>
<tr>
<td>0.1</td>
<td>MPa/bar</td>
</tr>
<tr>
<td>0.101325</td>
<td>MPa/atm</td>
</tr>
<tr>
<td>0.000133322</td>
<td>MPa/mmHg</td>
</tr>
<tr>
<td>0.3048</td>
<td>m/ft</td>
</tr>
<tr>
<td>0.0254</td>
<td>m/in</td>
</tr>
<tr>
<td>(10^3)</td>
<td>dm³/m³</td>
</tr>
<tr>
<td>(10^{-6})</td>
<td>m³/cc (= m³/cm³)</td>
</tr>
<tr>
<td>((0.3048)^3)</td>
<td>m³/ft³</td>
</tr>
<tr>
<td>((0.0254)^3)</td>
<td>m³/in³</td>
</tr>
<tr>
<td>3600</td>
<td>s/h</td>
</tr>
<tr>
<td>86400</td>
<td>s/day</td>
</tr>
<tr>
<td>(10^3)</td>
<td>g/kg</td>
</tr>
<tr>
<td>0.45359237</td>
<td>kg/lbm</td>
</tr>
<tr>
<td>231</td>
<td>in³/gal</td>
</tr>
<tr>
<td>42</td>
<td>gal/bbl (barrel)</td>
</tr>
<tr>
<td>0.0037854</td>
<td>gal/m³</td>
</tr>
<tr>
<td>6.289811</td>
<td>bbl/m³</td>
</tr>
<tr>
<td>(10^{-3})</td>
<td>Pa•s/cPoise</td>
</tr>
<tr>
<td>1.488</td>
<td>Pa•s/(lb/(ft•s))</td>
</tr>
</tbody>
</table>
A.2 K-Factor and inverse K-Factor conversions

Equation A-1: Frequency volumetric flow rate K-Factor

\[ KFactor = \frac{Freq\text{\_FullScale}}{(MaxFreq)3600\ \text{sec/hr}^{(*)}} \]

and

Equation A-2: Frequency volumetric flow rate inverse K-Factor

\[ InvKFactor = \frac{(MaxFreq)(3600\ \text{sec/hr}^{(*)})}{Freq\text{\_FullScale}} \]

where

\( KFactor \) = frequency “K-Factor” (pulses/volume**) (Freq1KFactor and Freq2KFactor)
\( InvKFactor \) = frequency “Inverse K-Factor” (volume**/pulse) (Freq1InvKFactor and Freq2InvKFactor)
\( Freq\text{\_FullScale} \) = frequency full-scale volumetric flow rate (volume**/time unit*) (Freq1FullScaleVolFlowRate and Freq2FullScaleVolFlowRate)
\( MaxFreq \) = maximum frequency (Hz = pulses/time unit*) (Freq1MaxFrequency and Freq2MaxFrequency)

(*) TimeUnit = time conversion factor depends on the VolFlowRate Time Unit data point:
  - volume/second = 1 s/s
  - volume/minute = 60 s/m
  - volume/hour = 3600 s/h
  - volume/day = 86400 s/d

(**) Volume = where the volume is selected via data points:
  - Units System
  - VolUnitUS
    - gallons
    - barrels
  - VolUnitMetric
    - cubic meters
    - liters
B Engineering drawings

B.1 Rosemount™ 3410 Series Ultrasonic Flow Meter Drawings

This appendix contains the following engineering drawing(s) for the ultrasonic meter:

| DMC-005324 | Rosemount 3410 Series Gas Ultrasonic Flow Meter System Wiring Diagram |

[Image of engineering drawing]